
Oracle® Fusion Middleware
Using Oracle GoldenGate Studio

12c (12.2.1.2.0)

E77903-01

October 2016

This document explains how to configure, customize, and run
the Oracle GoldenGate Studio to create and manage the
replication of data.



Oracle Fusion Middleware Using Oracle GoldenGate Studio, 12c (12.2.1.2.0)

E77903-01

Copyright © 2015, 2016, Oracle and/or its affiliates. All rights reserved.

This software and related documentation are provided under a license agreement containing restrictions on
use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your
license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license,
transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse
engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is
prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If
you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on
behalf of the U.S. Government, then the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software,
any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are
"commercial computer software" pursuant to the applicable Federal Acquisition Regulation and agency-
specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the
programs, including any operating system, integrated software, any programs installed on the hardware,
and/or documentation, shall be subject to license terms and license restrictions applicable to the programs.
No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications.
It is not developed or intended for use in any inherently dangerous applications, including applications that
may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you
shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its
safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this
software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of
their respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are
used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron,
the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro
Devices. UNIX is a registered trademark of The Open Group.

This software or hardware and documentation may provide access to or information about content, products,
and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly
disclaim all warranties of any kind with respect to third-party content, products, and services unless
otherwise set forth in an applicable agreement between you and Oracle. Oracle Corporation and its affiliates
will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party
content, products, or services, except as set forth in an applicable agreement between you and Oracle.



Contents

Preface ............................................................................................................................................................... vii

Documentation Accessibility .................................................................................................................... vii

Related Documents..................................................................................................................................... vii

Conventions................................................................................................................................................. vii

1    Introducing Oracle GoldenGate Studio

1.1    Introduction...................................................................................................................................... 1-1

1.2    How Do I Get Started? .................................................................................................................... 1-1

2    Using the Interface

2.1    Understanding the User Interface Basics ..................................................................................... 2-1

2.1.1    Oracle GoldenGate Studio Repository Login................................................................... 2-2

2.1.2    Menu Options ....................................................................................................................... 2-3

2.2    Setting Your Preferences................................................................................................................. 2-7

2.2.1    How to Set Preferences........................................................................................................ 2-7

2.3    Navigation Using the Keyboard.................................................................................................... 2-7

2.4    Using the Projects Navigator ......................................................................................................... 2-8

2.5    Using the Editor Area...................................................................................................................... 2-9

2.6    Using the Resources Navigator ..................................................................................................... 2-9

2.6.1    Add a New Data Server Connection ............................................................................... 2-10

2.6.2    Create a New View ............................................................................................................ 2-12

2.6.3    Add a New Global Mapping Group................................................................................ 2-13

2.6.4    Add a New Oracle GoldenGate Instance........................................................................ 2-13

2.7    Using the Properties Inspector..................................................................................................... 2-15

2.7.1    How to Use the Properties Inspector............................................................................... 2-15

3    Working with Solutions and Deployment Profiles

3.1    Understanding Projects................................................................................................................... 3-1

3.1.1    Creating a Project ................................................................................................................. 3-1

3.2    Understanding Solutions................................................................................................................ 3-1

3.2.1    Creating a New Solution ..................................................................................................... 3-2

3.3    Understanding Deployment Profiles ............................................................................................ 3-3

iii



3.3.1    Components of the Deployment Profile ........................................................................... 3-3

3.3.2    Toolbars in the Deployment Profile................................................................................... 3-5

3.3.3    Creating a New Deployment Profile ................................................................................. 3-6

4    Working with Mappings Groups

4.1    Understanding Mapping Groups.................................................................................................. 4-1

4.1.1    Schema and Table Mapping ............................................................................................... 4-1

4.1.2    Column Mapping ................................................................................................................. 4-3

4.1.3    Automap................................................................................................................................ 4-4

4.2    How to Create a Mapping Group ................................................................................................. 4-5

4.3    How to Assign Mapping Groups to Replication Path ............................................................... 4-6

4.4    How to Copy And Share Mapping Groups................................................................................. 4-6

5    Deploying and Monitoring Your Solutions

5.1    Deploying Solutions ........................................................................................................................ 5-1

5.1.1    How to Deploy a Solution................................................................................................... 5-1

5.2    Overview........................................................................................................................................... 5-2

5.2.1    Definition............................................................................................................................... 5-2

5.2.2    Deployment History ............................................................................................................ 5-2

5.2.3    Monitoring ............................................................................................................................ 5-2

5.2.4    Deployment Configuration................................................................................................. 5-3

6    Managing Security

6.1    Understanding Security in Oracle GoldenGate Studio.............................................................. 6-1

6.2    Using the Security Navigator......................................................................................................... 6-1

6.2.1    Adding a New User ............................................................................................................. 6-1

6.2.2    Modifying an Existing User ................................................................................................ 6-2

6.2.3    Deleting an User ................................................................................................................... 6-2

7    Troubleshooting

7.1    Positioning of Docked Windows................................................................................................... 7-1

7.2    Performance Issues While Using Oracle GoldenGate Studio ................................................... 7-1

7.3    Privilege Issue with Oracle GoldenGate Studio.......................................................................... 7-1

7.4    Syntax Errors with Generated Code ............................................................................................. 7-1

7.5    Not Able to Set Multiple Environment Variables ....................................................................... 7-2

7.6    Not Able to Add Resources............................................................................................................ 7-2

A    Concepts and Terminology

B    Relating Properties Inspector Options to Oracle GoldenGate Commands and
Parameters

B.1    Commands with Options ............................................................................................................... B-1

B.1.1    ADD EXTRACT Commands ............................................................................................. B-1

iv



B.1.2    ADD REPLICAT Commands............................................................................................. B-3

B.1.3    ADD EXTTRAIL Command............................................................................................... B-4

B.1.4    ADD RMTTRAIL Command ............................................................................................. B-4

B.1.5    REGISTER EXTRACT Command...................................................................................... B-5

B.1.6    START EXTRACT Command ............................................................................................ B-5

B.1.7    START REPLICAT Command ........................................................................................... B-5

B.1.8    ADD TRANDATA Command........................................................................................... B-6

B.2    Parameter Category Names........................................................................................................... B-7

B.3    Units of Measure ............................................................................................................................. B-8

B.4    Opposites .......................................................................................................................................... B-9

B.5    Other Oracle GoldenGate Parameters/Options ....................................................................... B-17

v



vi



Preface

This preface describes the document accessibility features and conventions used in
Oracle GoldenGate Studio Help.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/
topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/
topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Related Documents
The Oracle GoldenGate Product Documentation Libraries are found at

Oracle GoldenGate

Oracle GoldenGate Application Adapters

Oracle GoldenGate for Big Data

Oracle GoldenGate Director

Oracle GoldenGate Plug-in for EMCC

Oracle GoldenGate for HP NonStop (Guardian)

Oracle GoldenGate Monitor

Oracle GoldenGate Veridata

Oracle GoldenGate Studio

Conventions
The following text conventions are used in this document:
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http://docs.oracle.com/goldengate/1213/gg-monitor/index.html
https://docs.oracle.com/goldengate/v1221/gg-veridata/index.html
https://docs.oracle.com/goldengate/s1221/gg-studio/index.html


Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.
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1
Introducing Oracle GoldenGate Studio

This chapter introduces Oracle GoldenGate Studio and includes the following
sections:

• Introduction

• How Do I Get Started?

1.1 Introduction
Oracle GoldenGate Studio enables you to design and deploy high-volume, real-time
replication by automatically handling table and column mappings, allowing drag and
drop custom mappings, generating best practice configurations from templates, and
contains context sensitive help. With Oracle GoldenGate Studio, users new to Oracle
GoldenGate can start replicating data with minimal effort while experienced users
have access to GoldenGate's advanced replication options. Users new to Oracle
GoldenGate can start replicating data with minimal questions.Oracle GoldenGate
Studio provides you with the following abilities:

• Quickly create, modify, validate, deploy, and reuse GoldenGate best practice
designs.

• Define data flows once and deploy to literally thousands of locations.

• Graphically filter, map, and transform data.

• Apply global rules and exceptions.

1.2 How Do I Get Started?
Oracle recommends that you familiarize yourself with Concepts and Terminology and 
Relating Properties Inspector Options to Oracle GoldenGate Commands and
Parameters so that you have an understanding of what you will encounter in the
product and documentation.

You can follow the basic steps outlined in the following table to create and deploy
your replications:

Roadmap of Tasks

Begin by adding new database and GoldenGate connections to your Global Resource Library,
see Understanding Projects.

Use the wizards to create a Project, Replication Solution, and Deployment Profile. By default
each wizard will invoke the next. Solutions define the replicat process. The Solution and
Deployment Profile wizards provide you with pre-configured templates, see Understanding
Solutions.
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Roadmap of Tasks

Solution objects own Mapping groups, which describe the logical view of the replication
process. Use AutoMap or manually map schema, table, and column mappings then assign
them to your replication paths, see Understanding Mapping Groups.

Create a Mapping Groups and assign to the appropriate replication paths. You can reuse
Solution Mapping Groups in multiple replication paths for that solution and Global Mapping
Groups across in multiple replication paths across Project, see Understanding Mapping
Groups.

Add, remove, and fine tune any Oracle GoldenGate option or parameter, see Using the
Properties Inspector.

Deploy the Solution online to live Oracle GoldenGate instances or generate the parameter and
obey files locally for manual deployment, see, Understanding Deployment Profiles

Define any additional physical resources and assign them to your deployment profiles via
drag and drop from the Global Resource Library to the Deployment Profile diagram, see 
Understanding Deployment Profiles

Solutions also own one or more Deployment Profiles which describe the physical attributes of
a particular replicat deployment. You can create multiple deployment profiles. For example,
separate profiles for development, testing and production for a single Solution, see 
Understanding Deployment Profiles

Start, stop, and monitor all physical processes, see Monitoring

View deployment history information, see Understanding Deployment Profiles

Export solutions and mappings to XML files that can be imported by other Oracle
GoldenGate Studio users, see Using the Projects Navigator.

How Do I Get Started?
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2
Using the Interface

This chapter describes the Oracle GoldenGate Studio user interface and includes the
following sections:

• Understanding the User Interface Basics

• Setting Your Preferences

• Using the Projects Navigator

• Using the Editor Area

• Using the Resources Navigator

• Using the Properties Inspector

2.1 Understanding the User Interface Basics
Oracle GoldenGate provides highly optimized user interface for easy creation,
modification, and deployment of Oracle GoldenGate replication solutions.

There are two visible sections that appear when Oracle GoldenGate Studio is started.
The Project Navigator to the left and the Start Page to the right.

Screens shown in this guide may differ from your implementation, depending on the
skin and icons used. Any differences are cosmetic.
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Figure 2-1    Oracle GoldenGate Studio Main Window

The interface includes the tabbed editor area with a selection of other windows. The
primary windows used with the editor area when designing and deploying
GoldenGate replication solutions are:

• Projects Navigator

• Resources Navigator

• Properties Inspector

• Components Window

• Log Messages Window

• Security Navigator

You can also use the Tab key to change focus within a component and keyboard
shortcut Ctrl+Tab to change focus between different components.

2.1.1 Oracle GoldenGate Studio Repository Login
This is used to connect to Oracle GoldenGate Studio. The required connection details
are:

• LoginName: Name of the login defined to the repository.

• User: Oracle GoldenGate Studio user name.

• Password: Oracle GoldenGate Studio user password.

You can click New to create a new Oracle GoldenGate Studio login. When you save
your first repository connection definition you can save it using a secure wallet. The
secure wallet itself is password protected.

Understanding the User Interface Basics
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Click Edit to modify the existing Oracle GoldenGate Studio login with the Repository
Connection Information Editor.

Click Copy to copy a current login definition.

Click Delete to delete the existing Oracle GoldenGateStudio login.

For more information on repository database tables, see SNP_REV Tables Reference.

Note:   

To improve performance, the repository database needs to be in the same
LAN as the machine using Oracle GoldenGate Studio.

2.1.2 Menu Options
The menu options available in Oracle GoldenGate are as follows:

2.1.2.1 The File Menu

This menu is mainly used for file related activities such as:

• New: Used to create a new project, solution, deployment profile, mapping group,
data server connection, Oracle GoldenGate instance connection, and global
mapping group.

• Open: Used to open file.

• Close: Used to close the current editor tab.

• Close All: Used to close all the open editor tabs.

• Delete: Used to delete the currently selected object. If nothing is selected, this is
grayed out.

• Save: Used to save any changes done in the current editor tab.

• Save All: Used to save the changes in all open editor tabs.

• Page Setup, Print, Print Preview, Print Area: Used to set up the print options.

• Exit: Used to quit Oracle GoldenGate Studio.

2.1.2.2 The Edit Menu

The Edit menu is mainly used for editing locally generated parameter and obey files.
Any edits to these files will not be retained in the repository and will be overwritten
the next time files are generated. Functions include:

• Cut: Used to cut the selected item.

• Copy: Used to copy the selected item.

• Paste: Used to paste the selected item.

• Paste Special: Used to paste the selected item while retaining all the attributes.

• Delete: Used to delete the selected item.

Understanding the User Interface Basics
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• Multi-Cursor: Used to enable multi-cursor functionality. This menu is available
when a text file is opened in editor.

• Select All: Used to select all the available on screen items.

• Block Selection: Used to select a text block. This menu is available when a text file
is opened in editor.

• Properties: Used to open the Properties Inspector for an item.

2.1.2.3 The View Menu

The View menu is mainly used for viewing of toolbar, status bar and related viewing
areas. Functions include:

• Editor: Used to display the options for editor.

• Show Toolbars: Used to view different toolbars such as Main, Code Editor,
Properties, and Structure.

• Show Status Bar: Used to display the status bar.

• Refresh: Used to refresh the viewing area. If refresh is done on an editor tab, a
dialog box is displayed to confirm if you wish to revert back to the last saved copy.
It can be used as an alternative to undo.

• Full Screen: Used to display the product in full screen mode.

• Show Only Editor: Used to display only the editor area.

2.1.2.4 The Search Menu

The Search menu is used to find individual items in Oracle GoldenGate Studio. The
available options are:

• Find: Used to find a particular item.

• Find Next: Used to find the next instance of a particular item.

• Find Previous: Used to find the previous instance of a particular item.

• Find Usages: Used to find instances where the particular item is used.

2.1.2.5 The Diagram Menu

The Diagram menu is used to view and optimize the diagrams. This menu is visible
only when Solution Editor or Deployment Profile editor is selected. The options
include:

• Generate GoldenGate Files...: Used to generate the GoldenGate files. The specified
location must exist to complete this operation.

• Deploy: Used to deploy the solution. The status of the deployment action is
displayed in the Messages log. Online deployment is possible at solution level,
Oracle GoldenGate instance level, host level, and processes level. This option is
enabled only when an Oracle GoldenGate instance is associated with an actual
Oracle GoldenGate instance resource.

• Validate Deployment Profile: Used to validate the deployment profile. The
validation checks if any database specific options were incorrectly used.

Understanding the User Interface Basics
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For example, if you indicated in the GoldenGate connection that the database was
Oracle but tried to deploy to SQL Server, the validation will connect to the
GoldenGate instance and a warning is displayed in Messages log if any Oracle
specific options like integrated capture were used.

• Synchronize Profile with solution: Used to synchronize the deployment profile
with a solution. This option is enabled only when the profile is not synchronized
with the solution.

• Start: Used to start the selected process.

• Start...: Used to start the selected process with additional options.

• Stop: Used to stop the selected process.

• Kill: Used to kill (terminate) the selected process.

• Optimize Graphic Size: Used to set the optimal size of the graphic element.

• Bring to Front: Used to bring the selected graphic to the top layer.

• Send to Back: Used to send the selected graphic to the bottom layer.

• Zoom: Used to select the selected graphic to the required zoom level. You can
select a defined zoom level, zoom in, zoom out, fit window, or zoom to a selected
level.

2.1.2.6 The OGG Menu

The OGG (Oracle GoldenGate) menu includes the following:

• Connect: Used to connect to the repository.

• Disconnect: Used to disconnect from the repository.

• Repository Information: Used to display detailed information about the Studio
Connection and Database Connection. The Studio Connection includes the Studio
Login Name, User which is always SUPERVISOR, and SUPERVISOR password
that was defined while creating the repository. The Database Connection includes
the database user name for the repository schema and associated password, Driver
Name which is always oracle.jdbc.OracleDriver and the JDBC URL.

• Solution: Used to synchronize all profiles for a solution.

• Deployment: Used to online deploy, generate the Oracle GoldenGate parameter
and obey files for offline deploy, and to validate the deployment profile.

2.1.2.7 The Tools Menu

The Tools menu includes the following:

• Configure Components: This is grayed out.

• Preferences: Used to set the preferences. See Preferences section for more
information.

• Groovy: This is grayed out.

Understanding the User Interface Basics
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2.1.2.8 The Window Menu

The window menu is used to display different window within the editor. The
available options are:

• Projects Navigator: Used to display the Projects Navigator window. You can view
all the available projects, solutions, deployment profiles, and mapping groups.

• Security Navigator: Used to display the Security Navigator window.

• Components: Used to display the Components window. Components are only
displayed when the Solution diagram editor is selected.

• Extension Diagnostics: Used to display the extension logs.

• Log: Used to display the Log Messages Explorer.

• Properties: Used to display the Properties Navigator window.

• Resources: Used to display the Resources Navigator window. The main
components are Global Mappings, OGG Instances, and Database Connections.

• Structure: Used to view the structural representation of data of the currently
selected profile. The Structure window is enabled only when the Solution and
Deployment Profile diagrams are selected.

• Thumbnail: Used to display a representation of the current diagram for quick
navigation to a specific element on the diagram.

• Configure Window: This menu item consists a list of sub menu items to set the
window behavior such as minimize, maximize, float and so on.

• Reset Windows To Factory Settings: Used to reset all windows to their default
layout.

• Assign File Accelerator: Used to assign the file accelerators.

• Close Profile profile name: Used to close the active editor. If nothing is selected, this
is generally grayed out.

• Close All Documents: Used to close all open documents within the editor.

• Close other documents: Used to close other documents.

• Documents: Used to display the documents window which lists all available
documents. You can switch to a particular document, sort, save, or close a
document.

2.1.2.9 The Help Menu

The help menu includes the following options:

• Search: Used to search the online help system.

• Table of Contents: Used to display the table of contents for the online help system.

• Documentation Library: Used to open a browser window with a link to the related
documentation.

Understanding the User Interface Basics
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• Start Page: Used to display the Oracle GoldenGate product information page. You
can learn and explore the tutorials and help topics from this page.

• OGG Studio Forum: Used to open a browser window with a link to Oracle
GoldenGate studio forum posts.

• Oracle Technology Network: Used to open a browser window with a link to
Oracle Technology Network.

• About: Used to display the About dialog box with version information.

2.2 Setting Your Preferences
You can set the preferences for Oracle GoldenGate Studio including the environment,
audit behavior, and display.

The main components of this window are:

• Environment: Used to set the undo level, navigation level, and look and feel. All
warning messages can be reset from here.

– Log: Each activity can be logged. You can set the directory for saving log files,
maximum number of log lines, and log color options.

• Audit: This is grayed out.

• Code Editor: Used to open the editor.

• Database: Used to configure different database options. You can also select the
JDBC driver from the list of registered drivers, add a new driver, or delete an
existing driver.

• Diagrams: Used to set the options for diagrams.

– Annotation: Used to set the annotation options like color and font.

• Parameter Editor: Used to open the parameter editor.

• Web Browser and Proxy: Used to configure web browsers, proxy settings and
internet files.

– Web Browsers: Used to set the default web browser.

– Proxy Settings: Used to configure the proxy settings such as no proxy, system
default proxy, automatic proxy settings, and manual proxy settings.

– Internet Files: Used to enable cookies and clear all existing cookies.

2.2.1 How to Set Preferences
To set preferences, do the following:

1. In the Oracle GoldenGate Studio window, navigate to Tools > Preferences.

2. Modify individual items as per requirement.

2.3 Navigation Using the Keyboard
The following section describes the common methods of moving the cursor in Oracle
GoldenGate Studio.

Setting Your Preferences
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• Cursor control

• Operate Buttons

• Select Checkboxes

• Dropdown Lists and Combo Boxes

• List Boxes

• Radio Buttons

• Shuttles

• Sliders

• Spin Controls

• Text Fields

• Navigating Complex Controls

For more information, see OLINK:OJDUG172

2.4 Using the Projects Navigator
The Projects Navigator is used to browse and select existing solutions and solution
components such as Deployment Profiles, and Mapping Groups. The list of all active
projects are available through the Project drop-down option. You can refresh the
current project using the Refresh Projects Window button.

Figure 2-2    Projects Navigator

You can perform the following project related tasks using the Project Menu:

• Open project: Opens the editor for the currently selected project. If no project is
selected, this is grayed out.

• New project: Create a new project.

• Duplicate project: Duplicate an existing project and edit it after duplication.

• Delete project: Delete an existing project.

• Import project: Import a project XML file that was exported from Oracle
GoldenGate Studio.

• Export project: Export a project to an XML file.

Using the Projects Navigator
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2.5 Using the Editor Area
The editor area is used to visualize the organization and flow of the logical replication
solution with the physical objects for the physical deployment profile. You can add
data server and replication path components visually using drag-and-drop to evolve
the solution. The deployment profile architecture can be changed by selecting any part
of the replication path in the deployment profile diagram and selecting the desired
architecture template from the Properties Inspector.

Both the solution and deployment profile editors have an Overview tab. The solution
overview tab contains the solution definition and description and deployment
summary for all deployment profiles associated to that solution. The deployment
profile editor overview tab contains the deployment profile description, deployment
history for this profile only, monitoring, and deployment configuration options.

2.6 Using the Resources Navigator
The resources navigator, or the global resource library lists all the available resources
such as:

• Database: All the available databases.

• Views: Create new views.

• Global Mapping Group: Global mapping groups can be assigned to any replication
path of any solution across all projects. Mapping groups created for a solution in
the Projects Navigator can be copied to the global mapping groups or created
directly from the Resources Navigator.

• Oracle GoldenGate Instance: The available Oracle GoldenGate instances.

The Resources Navigator looks like:

Figure 2-3    Resources Navigator

Using the Editor Area
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There are three ways to add a new global resource. If any type of resource is not added
then you can add it by selecting the New button in the Resources Navigator toolbar,
select the New button in the Oracle GoldenGate Studio toolbar, or select New under
File menu, and then select the resource type you want to add. If a resource type has
already been added, you right-click the resource category and select New Resource
Type. You can add a Global Mapping Group by right-clicking a mapping group in the
Projects Navigator and selecting Copy to Global Resource Library.

Figure 2-4    Adding New Resources through Resources Navigator

You can change the properties of existing resources by using the Properties context
menu. You can also use the keyboard shortcut Ctrl+Tab to navigate to Resources
Navigator, use the Tab and arrow keys to select the particular resource, and use Shift
+ F10 to view the context menu.

2.6.1 Add a New Data Server Connection
New data server connections are used only for table metadata to facilitate table
mapping and are not used to define connections used by capture and apply processes.
Capture and apply connections are defined in the Properties Inspector in the
Deployment Profile.

A new data server connection wizard looks as follows:

Using the Resources Navigator
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Figure 2-5    New Data Server Connection

1. Select the Database resource type in the Resources Navigator window and right-
click to select New Database Connection.

2. In the New Data Server Connection window, add the following:

a. Connection Name: The name of the new connection. The resource is listed in
the Resources Navigator with the name mentioned here.

b. Connection Type: Connection types are Oracle(JDBC), MySQL, and
SQLServer.

c. The User name and Password to connect to the database. If you uncheck Save
Password check box during connection creation and if you want to expand
the Database node after re-connecting to repository, Database node expansion
will ask you to enter the password to show all the nodes under database
connection.

d. The role as SYSDBA or SYSOPER. This can be left blank when the user is not
SYS. Else, you have to select the role.

e. The Oracle JDBC settings.

By default, Oracle GoldenGate Studio provides drivers for Oracle, MySql, and
SQLServer. Data direct drivers are provided for Informix, DB2, and Sybase
but you can use any JDBC driver. Database driver can be configured by using
Tools menu, then Preferences , Database, and finally JDBC Driver Options.
Once a data server connection is created, you can browse objects under the
database in the Resources Navigator and the information from the database

Using the Resources Navigator
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navigator can be used for the mapping the tasks. Currently Oracle, MySQL,
and SQLServer drivers are certified.

3. Click OK to create a new Database resource.

You can also test the connection using Test Connection button before creating the
new resource.

2.6.2 Create a New View
You can create a new view using the Create New View wizard. It looks as follows:

Figure 2-6    Create New View

To create a new View:

1. Click the + sign for the database icon and select Views.

2. Right click to display the context menu and select New View....

3. Select the schema name from the Schema drop-down list.

4. Enter the name of the view.

5. You can enter the SQL code for the query part of the view definition, using the
SELECT and FROM keywords.

6. Click the Revert button to cancel any edits you have made since opening this
dialog, and display the contents of the box before these edits.

7. Click the Test button to open the Test Query window where you can:

• Verify the SQL statement

• View the results of running the query

• See the explain plan for the query

8. Click the DDL tab to view the SQL query that forms or defines the database object.

Using the Resources Navigator
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9. Select the Advanced check box (only in Create dialog) to come out of declarative
mode for this dialog and display the SQL Query page where you can enter the SQL
query directly.

10. Click the Check Syntax button to check the statement in SQL Query for any SQL
syntax errors. Possible results are:

• No errors found in SQL.

• Error(s) parsing SQL, location of the first error.

• The SQL syntax is valid, however the query is invalid or
uses functionality not supported.

11. Click OK to complete or Cancel to quit the wizard.

2.6.3 Add a New Global Mapping Group
The New Global Mapping Group wizard defines a container for table mappings but
does not guide you through the table mapping process. To learn more about defining
table mapping see Understanding Mapping Groups

A new Global Mapping Group wizard looks as follows:

Figure 2-7    New Global Mapping Group

To add a new Global Mapping Group:

1. Click the New button on the Resources Navigator window or right click on the
database icon and select New Global Mapping Group Connection.

2. Enter the name of the new connection.

3. Enter a short description to identify the resource.

4. Click OK.

2.6.4 Add a New Oracle GoldenGate Instance
The Add a New Oracle GoldenGate Instance dialog defines a connection to an existing
GoldenGate installation. That installation must already have the GoldenGate manager
and jAgent processes running

A new Oracle GoldenGate Instance dialog looks as follows:

Using the Resources Navigator
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Figure 2-8    New Oracle GoldenGate Instance Connection

To add a new Oracle GoldenGate Connection:

1. Click the New button on the Resources Navigator window or right click on the
database icon and select New Oracle GoldenGate Instance Connection.

2. Under General section enter the name and description for the new connection.

3. Under Host Information enter Host Name. It is the DNS name of the server where
Oracle GoldenGate is installed.

4. Under Oracle GoldenGate Information enter the following:

• GoldenGate Version: This gets automatically updated when Test Connection is
clicked. You can also select the version from the drop down list while working
offline. Test Connection only works if there is an active connection to database.
You can also work in offline mode and provide all the required information. If
there is an active connection and incorrect version is entered, the correct
database information is fetched from the database to overwrite the incorrect
version.

• GoldenGate Database Type: The database type for which the connection is
created. It gets automatically updated when Test Connection is clicked. You
can also select the version from the drop down list while working offline.

• GoldenGate Port: The port number for the Oracle GoldenGate manager process.

• Agent Username: The JAgent name as specified by the jAgent.username
property in the config.properties file of the jAgent at the time of
installation.

• Agent Password: The password for the corresponding username.

Using the Resources Navigator
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• Agent Port: The jAgent port as specified by the jagent.jmx.port property
in the config.properties file of the jAgent. If the agent mode is OEM, then
you have to use jagent.rmi.port, if the agent mode is OGGMON then you
have to use jagent.jmx.port.

5. Click Test Connection to GoldenGate to verify if the connection is working. The
version and database type is automatically updated on successful connection.

2.7 Using the Properties Inspector
The Properties Inspector is used to view and edit the attributes of the selected artifacts
in the solution diagram, deployment profile diagram, and mapping editor. You can
view a tool tip with a description of that particular parameter with a right-click in
Properties Inspector of the Deployment Profile. The Properties Inspector is dynamic
and the attributes correspond to the different types of items selected in the editor.

Figure 2-9    Properties Inspector

Relating Properties Inspector Options to Oracle GoldenGate Commands and
Parameters contains a list of all of the options that can appear in the Properties
Inspector of the Deployment View.

2.7.1 How to Use the Properties Inspector
To use the Properties Inspector, do as follows:

1. In Oracle GoldenGate Studio, navigate to Window menu and select Properties to
display the Properties Inspector.

2. In the Solution Editor, Mapping Editor, or Deployment View select an item for
which you want to change the property.

3. In the Properties Inspector, change the corresponding properties for that particular
item. Some items, such as conflict resolution in the mapping editor, requires

clicking a dynamic gear icon  that appears to the far right when you mouse over
the attribute.

4. Save the changes using the Save button on the toolbar or using the Save under File
menu. The changes in process parameters are available only after redeployment or
after regeneration of parameter files.

Using the Properties Inspector
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3
Working with Solutions and Deployment

Profiles

This chapter explains how to use solutions and deployment profiles to configure and
manage your replication solutions using Oracle GoldenGate Studio and includes the
following sections:

• Understanding Projects

• Understanding Solutions

• Understanding Deployment Profiles

3.1 Understanding Projects
A project is a container for a replication solution. Once created, they are presented as a
drop-down list at the top of the Projects Navigator. For more information, see Using
the Projects Navigator.

3.1.1 Creating a Project

1. Click the New button on the toolbar, from the File menu, select New, or select New
Project... from the Project Menu drop down list in the Projects Navigator.

2. Select Create New Project, then click OK.

3. Enter a name for you project. You can add a description as well.

4. (Optional) You can deselect the Continue to Solution Wizard if you do not want to
immediately create a solution for your new project.

5. Click OK.

Your project is created and is displayed in the list of projects.

3.2 Understanding Solutions
Solutions represent the replication patterns supported by Oracle GoldenGate and are
contained in a project. The concept of replication paths and mapping groups are all
part of the logical definition of a solution. Once the logical design is in place, you can
create multiple deployment profiles each with its own deployment template to match
the physical elements of your replication environments. A single Oracle GoldenGate
project can have multiple solutions.

One solution and its table mapping groups can be deployed to any number of physical
locations.

A typical solution contains:
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• Deployment Profiles: Describes the deployment architectural template, physical
resources and additional deployment options.

• Mapping Groups: A collection of source and target table mappings and associated
replication logic such as filtering and conflict detection rules. Table must be drag-
and-dropped from the Resources Navigator to the Mapping Editor. Then, source
and target table mapping associations can be automatically generated using
Automap or created by drag-and-drop from source to target and target to source.
Additionally, wildcard characters (*) can be used in the mappings at the schema
and table level. For Oracle multitenant support you must edit the schema name
manually to include the database name.

Readily available solution templates are available in Oracle GoldenGate Studio and
they greatly reduce the time required to create and deploy a solution.

3.2.1 Creating a New Solution
You can create a new solution as follows:

1. In the Projects Navigator, right-click and select New.

Figure 3-1    New Solution Dialog

2. Provide a name for the solution with an optional description, then click Next.

3. Select a solution template from Unidirectional, Bidirectional, or Hub and Spoke. If
Hub and Spoke is selected then enter the number of spokes.

A description appears for the selected template.

Understanding Solutions
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Figure 3-2    New Solution Template

4. (Optional) You can deselect the Continue with Deployment Profile Wizard if you
do not want to immediately create a deployment profile for your new solution.

5. Click Finish.

Your solution is created in the open project and is displayed in the Solutions
Navigator.

3.3 Understanding Deployment Profiles
The deployment profile is part of the Oracle GoldenGate Studio solution. It describes
the physical attributes of the replication solution. There can be more than one
deployment profile per solution. For example, one deployment profile for the
development environment, one for the test environment, and one for production.

Figure 3-3    Sample Deployment Profile Logical View

3.3.1 Components of the Deployment Profile
The different components of the deployment profile are:

Understanding Deployment Profiles
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3.3.1.1 Name of the Oracle GoldenGate profile

This is used to add a name and optional description to the deployment profile.

3.3.1.2 Deployment Architecture Template

This is used to define the architecture of deployment profile. When using the
Deployment Profile wizard the selected architecture template is applied to each and
every replication path in the solution. However, in the Properties Inspector, individual
replication paths may have different architecture templates.

The available architecture templates are:
Source, Target: The source and target deployment environments contain Oracle
GoldenGate instances local to the data servers. Capture and apply will both be done
locally.

Target Only (Remote Source): There is only one Oracle GoldenGate instance and it is
local to the target data server. Capture will be done remotely from the target.

Source Only (Remote Target): There is only one Oracle GoldenGate instance and it is
local to the source data server. Apply will be done remotely from the source.

Hub Only (Remote Source and Target): There is only one Oracle GoldenGate instance
and it is on a stagging server. Capture and apply are both done remotely.

Source, Hub, Target: There are three Oracle GoldenGate instances. One is local to the
source data server and one is local to the target data server. Capture and apply are
both done locally and data will be transmitted through a third Oracle GoldenGate
instance on a hub between the two.

Hub, Target (Remote Source): There are two Oracle GoldenGate instances, one on a
staging hub and one on the target data server. Capture is done remotely from the hub
while apply is done locally at the target.

Source, Hub (Remote Target): There are two Oracle GoldenGate instances, one is on
the source data server and one is on a staging hub. Capture is done locally from the
source data server while apply is done remotely from the target data server from the
hub.

Single Host (Local Source and Target): There is only one host and it contains both the
Oracle GoldenGate instance and source and target data servers.

3.3.1.3 Assign Physical Resources

This is used to assign your resources to the source, the target, and the hub (if
applicable) of the replication path.

The resource assignment section contains:
Replication Path: It describes the data store mapping information.

Source: Select the Data Server and Oracle GoldenGate Instance to use as the source of
each replication path.

Target: Select the Data Server and Oracle GoldenGate Instance to use as the target of
each replication path.

Hub: Select the Data Server and Oracle GoldenGate Instance to use as the hub of each
replication path.

Understanding Deployment Profiles
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Note:   

Resource assignment can also be done or re-done through the Deployment
Profile editor by dragging and dropping resources from the Resources
Navigator to the appropriate diagram elements.

3.3.1.4 Deployment Options

This is used to select several additional options such as initial load of all targets, and
starting of all or selected Oracle GoldenGate processes.

Deployment options include:
Initial load of all targets: Select if data must be copied between systems before changes
to the data are applied.

Start All Oracle GoldenGate Processes: Select which (or all) processes should be started
after deployment:

• Capture Process

• Pump Process

• Apply Process

Note:   

Processes can be started only during online deployment.

3.3.2 Toolbars in the Deployment Profile
The toolbar buttons are described in sequence with the following image:

Figure 3-4    Deployment Profile Toolbar

Some buttons like validate and start are context sensitive and change color when
enabled.

• Zoom In: Click to increase size of the on screen components

• Zoom Out: Click to decrease size of the on screen components.

• Percent View: Click to set the view to a predefined percentage value.

• Perform Layout: Click to automatically rearrange the components in the
deployment view in a organized way. You can save the layout using the Save
button in the toolbar or selecting Save under File manu. The data flow is from left
to right.

• Synchronize Profile with Solution: Click to synchronize the deployment profile
with a solution. This option is enabled only when the profile is not synchronized
with the solution.

• Deploy Solution: Click to deploy the solution. The status of the deployment action
is displayed in the Messages log. Online deployment is possible at solution level,

Understanding Deployment Profiles
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Oracle GoldenGate instance level, host level, and processes level. This option is
enabled only when an Oracle GoldenGate instance is assigned with an actual
Oracle GoldenGate instance resource.

• Validate Deployment Profile: Click to validate the deployment profile. The
validation checks if any database specific options were incorrectly used. For
example, if you indicated in the GoldenGate connection that the database was
Oracle but tried to deploy to SQL Server, the validation will connect to the
GoldenGate instance and a warning is displayed if any Oracle specific options like
integrated capture were used. Validation warnings, if any, are displayed in the
Messages log.

• Generate GoldenGate Files: Click to choose a local directory in which GoldenGate
files will be generated.

• Start the Selected Process: Click to start the selected process.

• Stop the Selected Process: Click to stop the selected process.

• Kill the Selected Process: Click to kill the selected process.

3.3.3 Creating a New Deployment Profile
To create a new deployment profile:

1. Name your Deployment Profile: Provide a name for the deployment profile and
click Next. Clicking Finish creates a profile that defaults the Replication Path,
Source, and Target using automatically generated names and settings for the
solution.

2. Deployment Template: Select an architecture to be used as the template for the
solution. The deployment architecture template describes where Oracle
GoldenGate is installed in relation to data servers. The selected template is applied
to all replication paths and can be customized on a replication path-by-replication
path basis subsequently. You can change a previously selected deployment
architecture template by clicking the template link in the Deployment View and
selecting a new template in the Properties Inspector.

Deployment
Architecture Template

Description

Source, Target The source and target deployment environments contain
Oracle GoldenGate instances local to the data servers. Capture
and apply will both be done locally.

Target Only (Remote
Source)

There is only one Oracle GoldenGate instance and it is local to
the target data server. Capture will be done remotely from the
target.

Source Only (Remote
Target)

There is only one Oracle GoldenGate instance and it is local to
the source data server. Apply will be done remotely from the
source.

Hub Only (Remote
Source and Target)

There is only one Oracle GoldenGate instance and it is on a
stagging server. Capture and apply are both done remotely.

Understanding Deployment Profiles
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Deployment
Architecture Template

Description

Source, Hub, Target There are three Oracle GoldenGate instances. One is local to
the source data server and one is local to the target data
server. Capture and apply are both done locally and data will
be transmitted through a third Oracle GoldenGate instance on
a hub between the two.

Hub, Target (Remote
Source)

There are two Oracle GoldenGate instances, one on a staging
hub and one on the target data server. Capture is done
remotely from the hub while apply is done locally at the
target.

Source, Hub (Remote
Target)

There are two Oracle GoldenGate instances, one is on the
source data server and one is on a staging hub. Capture is
done locally from the source data server while apply is done
remotely from the target data server from the hub.

Single Host (Local Source
and Target)

There is only one host and it contains both the Oracle
GoldenGate instance and source and target data servers.

Select the deployment architecture template from the list of available templates and
click Next.

Figure 3-5    Deployment Architecture Template

The contents of the Physical Resources step is populated based on your
deployment template selection.

3. Assign Physical Resources: Use this to assign your resources to the source, target,
and hub (if applicable) of the replication path.
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Source

Select the Data Server and Oracle GoldenGate Instance to use as the source of each
replication path.

Target

Select the Data Server and Oracle GoldenGate Instance to use as the target of each
replication path.

Hub

Select the Data Server and Oracle GoldenGate Instance to use as the hub of each
replication path.

Note:   

Resource assignment can also be done or re-done through the Deployment
Profile editor by dragging and dropping resources from the Resources
Navigator to the appropriate diagram elements.

The deployment template is the same for all replication paths in a given solution.
Some templates do not require data stores.

Figure 3-6    Physical Resources in Deployment Profile

4. Deployment Options: Select or deselect any applicable Oracle GoldenGate starting
process deployment options.
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Initial load of all targets

Select if data must be copied between systems before changes to the data are
applied.

Start All Oracle GoldenGate Processes

Select which (or all) processes should be started after deployment:

• Capture Processes

• Pump Processes

• Apply Processes

Note:   

Processes can be started only during online deployment.

Figure 3-7    Deployment Options

Click Finish. Your deployment profile is created and added to the Solution.

Understanding Deployment Profiles
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4
Working with Mappings Groups

This chapter explains how to use local and global mappings groups to configure and
manage your replication options using Oracle GoldenGate Studio and includes the
following sections:.

• Understanding Mapping Groups

• How to Create a Mapping Group

• How to Assign Mapping Groups to Replication Path

• How to Copy And Share Mapping Groups

4.1 Understanding Mapping Groups
In Oracle GoldenGate Studio, the term mapping group is used to explain a collection
of source and target table mappings and associated replication logic such as filtering
and conflict detection rules. First, the tables must be drag and dropped or added using
the keyboard shortcuts from the Resources Navigator to the Mapping Editor. Then,
source and target table mapping associations can be automatically generated using
Automap or created by drag-and-drop or using keyboard shortcuts from source to
target and target to source. Additionally, wildcard characters (*) can be used in the
mappings at the schema and table level. If you drag and drop the schema name it will
automatically use a wildcard, indicating all tables. For more on wildcard logic see the
Orcale GoldenGate Reference manual. For Oracle multitenant support you must edit
the schema name manually to include the pluggable database name.

Only the metadata from the database connections are used when creating mapping
groups. This means mapping groups are logical constructs which can be assigned to
multiple replication paths. Mapping groups local to a solution can be associated with
any replication path in that solution, while global mapping groups located in the
global resource library, can be used for any replication path for any solution across all
projects. When a mapping group is modified that change will be reflected in all
replication paths referencing that mapping group. More than one mapping group can
be assigned to a replication path.

For example, if you have 100 stores with the same application schema reporting back
to a central data warehouse, you only have to define that mapping group once and
you can apply it to all 100 replication paths. Any changes to that mapping group will
only needs to be made once and will be reflected in all 100 replication paths.

4.1.1 Schema and Table Mapping
Schemas are not directly mapped to other schemas. Tables in the schemas are mapped
other tables. To map all tables in a schema you can either highlight all of the tables in
the global resource library and drag and drop them into the mapping editor or you
can drag and drop the schema name, which will then use a wildcard (*) for all tables. If
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you're replicating DDL and want to capture new tables then always use a wildcard.
Wildcard can also be used with schema names. However, when using a wildcard for
schema names, some system schemas will automatically be excluded. To see which
schema names will be implicitly excluded when using wildcards, refer Oracle
GoldenGate installation document for that database. When using a wildcard for the
schema name, the implicitly excluded schemas can be overridden by explicitly listing
the schema names.

To map tables or wildcards you can click the Automap button and any unmapped
target table will be mapped to a source table if the table names are the same regardless
if they are in different schemas. Alternatively, in the mapping editor you can drag and
drop source and target table names on each other to create the association.

Once tables are mapped you will see the Source table name in the Target column
Mapped From. Only the Source table names are listed in this column but a tool tip will
provide the source schema name. Double clicking the Target table name or Mapped
From table name will take you to the column mapping editor.

In the schema and table mapping editor you can define properties and logic for the
entire mapping, source tables, and target tables. The following figure and the table
show which properties can be edited based on where you click in the mapping editor.

Figure 4-1    Schema and Table Mapping

ID UI Element Properties

1 Map Breadcrumbs Name and description, DDL replication, global column
matching, DML conversions, and global replication error
responses.

2 Source schema name Database name, schema name, and exclude schema from
source capture. The exclude schema is used when you have
used a wildcard for all schemas but want to explicitly exclude
certain schemas that would otherwise be included with the
wildcard.

3 Source table name Table name, exclude table from source capture, filter, Where
clause, custom SQL execution, event actions, and additional
custom properties.

4 Target schema name Target schema name and exclude schema from target apply
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ID UI Element Properties

5 Target table name and
Mapped From

Target schema name and exclude table from target apply,
exception handling, filter, DML conversion, Where clause,
table specific replication error responses, custom SQL
execution, coordinated apply thread (if applicable),
coordinated apply thread range (if applicable), event actions,
more settings, and additional custom properties.

In Mapping Editor, when there are two tables and you select the Source table for
Exclude, Oracle GoldenGate Studio does not generate table statement for following
tables. You have to select Exclude for the target table to correctly generate the table
statements.

Note:   

When you have more than one table mapped you will need to drill into
column mapping and select the table name to edit all the properties except
exclude property. This allows you to apply different logic to different tables.

4.1.2 Column Mapping
You can navigate to the column mapping from the table mapping editor. Double click
the Target table name or the Mapped From column, or right-click anywhere on the
target row that contains the table name and chose Edit Column Mapping from the
context menu.

The Oracle GoldenGate runtime engine automatically maps matching column names
so column mapping is not required. Column mapping works in the same way as table
mapping and you can use Automap and drag-and-drop between Source and Target.

In the column mapping editor you can define properties and logic for Source and
Target tables and columns. The following figure and the table show which properties
can be edited based on where you click in the mapping editor. It also shows how to
select individual table mappings when more than one table is mapped to a target table
and how to navigate back to the schema and table mapping editor.

Note:   

Selecting the table name in the column mapping editor provides the same
options as clicking the table name in the schema and table mapping editor
when there is only one source table mapped to the target table.

Understanding Mapping Groups
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Figure 4-2    Column Mapping

ID UI Elements Properties

1 Map Breadcrumbs
showing mapping group
name

Selecting here returns to the schema and table mapping
editor.

2 Map Breadcrumbs
showing table mapping
name

If there is more than one source table mapped to this target
table, selecting here provides a drop down list of those
other mappings and you can navigate to them.

3 Source table name Table name, exclude table from source capture, filter,
Where clause, custom SQL execution, event actions, and
additional custom properties

4 Source column name Column name, exclude column from source capture, force
column to be used as (part) of the primary key.

5 Target table name Target table name, exclude table mapping from target
apply, force specific columns to be used as the key,
exception handling, conflict detection, conflict resolution,
filter, DML conversion, Where clause, table specific
replication error responses, custom SQL execution,
coordinated apply thread (if applicable), coordinated apply
thread range (if applicable), event actions, more settings,
and additional custom properties.

6 Target column name and
Mapped From

Column name, mapped from (which can contain source
column names or custom logic), force column to be used as
(part) of the primary key, enable this column for update
conflict detection, and enable this column for delete
conflict detection.

Note:   

Primary key column overrides, conflict detection, and conflict resolution are
only present in the column mapping editor.

4.1.3 Automap
The Automap feature automatically maps similarly named tables. Automapping
assignments are created from the source to target and not the reverse. The mapping
window looks as follows:
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Figure 4-3    Automap

4.2 How to Create a Mapping Group
To create a new local or global mapping group:

1. To create a mapping group that is local to the solution, select the Mapping Groups
under that solution and right-click to select New. To create a global mapping
group, right-click to Global Mapping Group in the Resources Navigator. If the
Resources Navigator has no global mapping groups then click the plus icon +in the
Resources Navigator, select Global Resource Library, and then select Global
Mapping Group.

The Create New Mapping Group or New Global Mapping Group window opens.

2. Provide a name and optional description for the Mapping Group and click OK.

3. If the mapping editor window does not open automatically, double click the new
mapping group in the Projects Navigator or Resources Navigator.

4. Add tables from the Global Resource Library by dragging and dropping them from
the library into the source and target panes of the mapping editor.

To select a list of tables you can use Shift-click on the first and last table in the set,
use Control-click to select multiple individual tables, or use the + button in the
source and target mapping editor panes to manually add schema and table names.
In the column mapping editor the equivalent + button allows you to add columns
manually.

5. Drag and drop the table or schema names from either the Source or Target pane to
the other pane to create a source/target table mapping. If you drag the tables to a
white area it will do an exact 1:1 mapping. If you drag a table name from one pane
to the other and drop it directly on the other table name, it will create an explicit
mapping.

For example, if Table EMP1 in Source is to be mapped with EMP_BACK1 in Target,
drag EMP1 from Source and drop it on EMP_BACK1 at Target. EMP_BACK1 appears
as a Mapped From table for EMP1 indicating a successful mapping.

You can also use the keyboard to perform the same action. When a source or target
schema does not have a reference to any specific Resources Navigator schema and
the name matches a particular database name in the Resources Navigator, a
confirmation dialog is displayed to associate the resource. You can select Yes to
complete the mapping.

If you select a table as target in the Mapping Editor which is not mapped, the
Properties Inspector displays a Mapped From text box. You can enter the source
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table name which will be validated against a valid source table references and can
be mapped to target table if the source table is valid.

6. You can also use the AutoMap button to automatically create mappings for table
names that are same between Source and Target. Source tables can be mapped to
more than one Target table and more than one Source table can be mapped to a
single Target table.

4.3 How to Assign Mapping Groups to Replication Path
Mapping group is assigned in the solution editor. To assign a local or global mapping
group to a replication path, drag the mapping group from the Projects Navigator or
Global Resource Library and drop on the replication path or data server in the solution
editor. If dropped onto a data server, the mapping group will be automatically
associated with every replication path connecting that data server. If dropped on the
replication path arrow, the association will be only for that path. You can drag the
same mapping group and drop on multiple paths and data servers. These associations
are by reference and not copies. Any change to the mapping group is automatically
reflected in every replication patch associated with that mapping group.

To remove a mapping group from a replication path, select the replication path in the
solution editor and in the Properties Inspector you will see a list of all replication path
mapping associations. Select the desired mapping group name and click the red X icon
to delete. A confirmation dialog appears.

In the Properties Inspector of the replication path, there is a green + icon, which
provides an alternative way to add an association between a mapping group and
replication path. When the + icon is selected, through a dialog box you can add
association for local and global mappings to this replication path.

4.4 How to Copy And Share Mapping Groups
When you right click a local solution mapping group you can see options to copy it to
the Global Resource Library, make a copy (duplicate) of the selection within the same
solution, and export it to an XML file. The XML file can be used for import in another
Oracle GoldenGate Studio repository. You can right-click the global mapping group
and export to an XML file that can be imported by other Oracle GoldenGate users
outside of your shared environment. The export map dialog supports character set
and encryption settings.

You can import both local and global exported mapping groups by right-click to the
appropriate Mapping Groups node in the Projects Navigator and selecting Import.
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4-6  Using Oracle GoldenGate Studio



5
Deploying and Monitoring Your Solutions

This chapter describes how to deploy and monitor your solutions and includes the
following sections.

• Deploying Solutions

• Overview

5.1 Deploying Solutions
You can choose to deploy your solution either in Online of Offline mode in Oracle
GoldenGate Studio.

• Online Deploy: Online deployments require that the Oracle GoldenGate instances
associated in the deployment profile have both the manager and Oracle
GoldenGate Monitor JAgent is installed and running.

See olink:GGAIN

• Offline Deploy: Oracle GoldenGate Studio will generate the GoldenGate replication
parameter and obey files and save them in a local directory.

The online deployment implicitly runs a validation check by pinging the GoldenGate
instances that have been assigned as resources in the deployment profile and ensures
that the minimum required parameters have been set for those data server types. Any
parameter that is set and is not related to the data server type to which you are
deploying will be ignored when generating the parameter and obey files.

You can also explicitly run a validation by selecting the green check mark icon in the
deployment profile toolbar.

Before writing the configuration and command files, the JAgent backs up any files it
is about to overwrite to the dirtmp directory of the Oracle GoldenGate instance. Any
conflicting process will be stopped. If you did not deselect the start option in the
Deployment Configuration options the process will be started once the new
configuration files are created.

Once a deployment profile has been deployed you can view the deployment history
and some simple monitoring matrixes in the Overview tab under Deployment Profile
next to the Deployment View tab. Deployment Configuration options can also be
found in the Overview tab under Deployment Profile. Those options include starting
all GoldenGate processes and performing full initial loads. Currently partial initial
loads are not supported.

5.1.1 How to Deploy a Solution
A solution can be deployed in several ways as follows:

1. Through Deployment Profile Toolbar.
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2. Through the context menu in Deployment Profile editor.

3. Through the Projects Navigator Deployment Profile Node.

For example, to deploy a solution through the Projects Navigator:

1. In the Projects Navigator, select the Deployment Profile you want to deploy and
right-click to select Deploy.

2. Select between Deploy or Generate GoldenGate Files. Deploy is used for online
deployment while the files generated by Oracle GoldenGate are used for offline
deployment.

3. Follow the on screen instructions to continue with deployment.

For offline deployment, you can select a directory to save the deployment files.

5.2 Overview
This tab is used to edit information regarding the name and description of the
deployment profile, deployment history, and deployment configuration.

5.2.1 Definition
Use this tab to edit high level details of the deployment profile. The available fields
are:

• Deployment Profile Name: You can view and edit the name of the deployment
profile.

• Description: You can add or edit the description of the deployment profile.

5.2.2 Deployment History
It provides a historical record of past deployments for a project, solution, deployment,
or a single deployment profile.You can use the Select Columns icon in the table's
toolbar to tailor your view of the deployment history information. Columns can be re-
ordered as per requirement.

The available columns are:

• Last Deployed

• Deployment Status

• Deployed By

• Comments

• Process Name

• Process Type

• Instance Name

5.2.3 Monitoring
Detailed information on the status of every process can be viewed under Monitoring.
Additionally, you can monitor the status of each process currently deployed on an
Oracle GoldenGate instance, such as the status, type, and mode of processes.

Overview
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The tab looks as follows:

Figure 5-1    Monitoring Tab

The available columns are:

• Status

• Process Name

• Type

• last-operation-lag

• Mode

• last-operation-timestamp

• last-checkpoint-timestamp

• Total Inserts

• Total Deletes

• Total Updates

5.2.4 Deployment Configuration
Use this tab to view or edit the deployment options and physical resources.

You use the Deployment Settings checkboxes to control which processes to start
automatically. The Replication Path Table represents all replication paths in the
deployment profile. You can control whether or not to generate code for an initial load
for each of those replication paths.

Overview
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6
Managing Security

This chapter explains how to manage your the security of your replications using
Oracle GoldenGate Studio and includes the following sections:

• Understanding Security in Oracle GoldenGate Studio

• Using the Security Navigator

6.1 Understanding Security in Oracle GoldenGate Studio
The Security Navigator is used to manage the Security in Oracle GoldenGate Studio. It
is also used to create users and profiles, and to set an account expiration date. Users in
Oracle GoldenGate Studio can be Superusers, or Admin, or Administrator and they
have same privilege irrespective of name.

The Security Navigator looks as follows:

Figure 6-1    Security Navigator

6.2 Using the Security Navigator
You can do the following tasks using the Security Navigator:

6.2.1 Adding a New User
To add a new user, do as follows:

1. Click on the user button and select New User.

2. Provide the name, password, and account expiration date (optional).

By default, all users have Supervisor access privilege.
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3. Click the Save button in the toolbar.

6.2.2 Modifying an Existing User
To modify an existing user, do as follows:

1. Right click on the user and select Open.

2. Modify the user name, password, or account expiration date.

3. Click the Save button in the toolbar.

6.2.3 Deleting an User
To delete an existing user, do as follows:

1. Right click on the user and select Delete.

2. In the confirmation dialog box, click Yes.

Using the Security Navigator
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7
Troubleshooting

This chapter describes common issues that may occur and how you can solve them.

• Positioning of Docked Windows

• Performance Issues While Using Oracle GoldenGate Studio

• Privilege Issue with Oracle GoldenGate Studio

• Syntax Errors with Generated Code

• Not Able to Set Multiple Environment Variables

• Not Able to Add Resources

7.1 Positioning of Docked Windows
Issue: Multiple docked windows like Projects Navigator, Component pallets and so on
are misplaced and do not fit the main application window properly.

Solution: Navigate to Window menu and click Reset Windows To factory Settings.

7.2 Performance Issues While Using Oracle GoldenGate Studio
Issue: Severe performance issue when using Oracle GoldenGate Studio.

Solution: Ensure that the repository is installed in the same LAN.

7.3 Privilege Issue with Oracle GoldenGate Studio
Issue: All users have Supervisor privileges.

Solution: To prevent contention against the same set of objects, it is recommended that
Projects and Solutions are well planned in terms of who is working on the same
objects.

7.4 Syntax Errors with Generated Code
Issue: Syntax errors are present.

Solution: Check is the version and database values of the data servers assigned to the
deployment profiles. Generated Code will be compatible with the assigned data
servers.

Next, check is to see if the code can be successfully parsed by Oracle GoldenGate Core
product. If the syntax is successfully parsed by that tool, then the Oracle GoldenGate
Studio and Core files are compatible.
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If it is not successfully parsed and the error is not in the mapping syntax, then you can
contact Oracle Support.

7.5 Not Able to Set Multiple Environment Variables
Issue: User is not able to set multiple environment variables with GETENV and SETENV
in Properties Inspector.

Solution: Environment variable SETENV is available in Properties Inspector, and user
can set it multiple times. GETENV can be used by manually typing it in one the column
mapping page in Properties Inspector Mapped From: directly under the Name: You
can also manually type it in other free text areas such a FILTER, SQL Execution,
WHERE, and so on.

7.6 Not Able to Add Resources
Issue: Not able to set add resources using drag-and-drop.

Solution: Ensure that you are dropping the resources to correct targets and to solution
editor links instead of Mapping Group to Deployment Profile links. You can add
physical resources only to the Deployment Profile view.

Not Able to Set Multiple Environment Variables
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A
Concepts and Terminology

The table in this appendix describes the concepts and terms that are used in the Oracle
GoldenGate Studio product and documentation.

Term Description

Apply An Oracle GoldenGate process that will write the changes captured in
a trail file to a target data server.

AutoMap Functionality that makes mapping recommendations based on pattern
matching of schema, table and column names and data types.

Bidirectional Name of a solution template that has a single source and single target
with replication paths in both directions.

Business Entity Logical representation of data that records a business or agency
activity, usually regarding the sale, distribution or development of a
product or a service.

Capture An Oracle GoldenGate process that writes records relating to change
data from a source system (database or JMS queue) into binary files
(trails).

CDR Conflict Detection and Resolution. A specific use case of error
detection and response logic found typically in bidirectional and
Active-Active solutions.

Column Mapping The mapping of columns and fields between two tables or other data
entities.

Conflict Detection A specific use case of error detection.

Conflict Resolution A specific use case of error response.

Connections Information used to attach to a data server or Oracle GoldenGate
instance.

Consolidation Name of a solution template where many sources map to a single
target.

Credential Store The Oracle GoldenGate credential store manages user IDs and their
encrypted passwords (together known as credentials) that are used by
Oracle GoldenGate processes to interact with a database.

Data Entity Typically a table but any data object that can be replicated including a
sequence but not replicated logic such as procedures.
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Term Description

Data Server Most commonly a database but can be any external (to GoldenGate)
source or target of data (e.g. JMS). They contain information about
data entities that are replicated (e.g. tables) as well as procedural logic
that affect data (e.g. triggers and procedures). Can be used as a source
or target.

Data server login
credentials

Username and password to access data server.

DDL Data definition language statements that can be replicated between
like databases.

Deployment Physical architecture bound to a logical design that contains one or
more profiles.

Deployment
Assistant

A sequence of dialog boxes that leads the user through creating a
physical deployment, then allows the user to assign GoldenGate
instances to replication paths, and provides additional deployment
options such as perform initial load.

Deployment History Contains a historical manifest of deployments and can be viewed in
the context of a project, solution, deployment or a single deployment
profile.

Deployment Profile The physical architecture plus the physical properties of specific
processes (their names, behavior options, environmental settings) It
contains the details that binds the logical design to the physical
architecture.

Deployment
Template

The physical relationship of data servers, GoldenGate instances, and
hosts.

Description Text field that contains the name and description for a Project,
Solution or Deployment.

Distribution Name of a solution template that has a single source and multiple
targets.

Document Tab Tabs along the top of the interface that display solutions, library
mappings and library logic.

Editor Tab Tab located at the bottom of the interface that is subordinate to the
Document Tab.

Exception Mapping One or more auxiliary mappings that are invoked only when the
primary mapping encounters and error.

Filter Component of mapping to define rules to omit rows.

Folder An interface construct used to select and visually organize related
objects such as, mappings, logic and connections.

Functions Oracle GoldenGate built in logic constructs that can act on change data
or metadata resulting in the transformation, inclusion, or exclusion of
column data. Used in the expression editor.

Oracle GoldenGate
Agent

Heavy weight agent designed to monitor Oracle GoldenGate instances
with minimal management capabilities.
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Term Description

Oracle GoldenGate
Gallery

A sequence of dialog boxes that leads the user through creating new
Oracle GoldenGate Studio Projects, Solutions, Deployments and
Connections.

Oracle GoldenGate
Instances

The connection details for an Oracle GoldenGate Instance available in
the Resources Navigator.

Oracle GoldenGate
processes

Processes and services that are part of the GoldenGate instance used
for capturing, transferring, modifying, and applying data.

Hub and Spoke Name of a solution template. Distributed data model consisting of
connections arranged like a wheel, in which all traffic moves along
spokes connected to the hub at the center.

Initial Load The copying of data between systems before changes to that data are
applied.

Library A collection of shared mappings or logic code that can be used in
more than one solution or project.

Logic library Logic code used in mapping and error handling that can be used in
more than one solution or project.

Logical Design One or more data servers with connected replication paths.

Mapping Library A collection of maps that can be used in more than one solution or
project.

Mapping/Map The assignment of one or more data entities to another or one or more
statements to a data server.

Mappings First-level construct containing the mapping of data entities,
statements, and associated logic that is not shared beyond the local
solution.

Overview Name of an editor level tab under solution that provides high level
details of the solution as well as control over access privileges.

Parameters The set of all configurable items relating to the runtime behavior of
Oracle GoldenGate processes used in replicating and loading data.
Broken down into several areas, the most significant relating to the
mapping logic.

Project The highest level object containing Oracle GoldenGate solutions.

Project Wizard A sequence of dialog boxes that leads the user through creating a new
project.

Projects Navigator The interface used to select Oracle GoldenGate Studio projects.

Properties Inspector Shows attributes of selected artifacts and provide a means to change,
add, or remove those attributes.

Replication Path The path denoting one direction of change data as it moves between
data servers. Two data servers can have from zero to two direct
replication path connections but only one path in each direction.

Replication Source Data server from which data is read, copied and transmitted.
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Term Description

Resource Data Server and Oracle GoldenGate connections and mapping library.

Resource
Assignment

The act of assigning physical resources.

Resources Navigator Interface used to select Oracle GoldenGate Studio resources.

Schema Mapping The mapping of schemas and tables.

Security Navigator The interface used to select Oracle GoldenGate Studio security
options.

Solution A deployable object representing a replication design. The design
view describes data servers, replication paths, mappings and a logical
design. The deployment profile describe the resource assignments
involved in the physical design. Solutions can contain more than one
deployment profiles. A single solution design can be deployed to any
number of physical systems by creating a deployment profile for each.

Solution Wizard A sequence of dialog boxes that leads the user through creating a new
solution by providing a menu of common solution templates, and then
allows the user to add existing mappings, bind data server
connections to the logical design, and finally include mappings from
the mapping library.

Solution Navigator The interface used to select Oracle GoldenGate Studio solutions,
mappings, logic, and deployments.

Solution Templates Preconfigured solution templates are provided.

Structure Panel Auxiliary navigator to show additional detail beyond what higher
level navigators allow.

Target Data server to where data is written.

Trail Sequenced set of binary files used to queue and read captured
transactions by Oracle GoldenGate.

Unidirectional Name of a solution template that has one source replicating to one
target.

Wallet Digital Oracle wallet used to store encryption keys and managed and
used by Oracle GoldenGate processes to encrypt and decrypt data at
rest and in flight.
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B
Relating Properties Inspector Options to

Oracle GoldenGate Commands and
Parameters

This appendix provides a correlation between the Oracle GoldenGate commands and
parameters that are run when you select the various options in the Properties
Inspector and includes the following sections:

• Commands with Options

• Parameter Category Names

• Units of Measure

• Opposites

• Other Oracle GoldenGate Parameters/Options

You can find information about all Oracle GoldenGate commands and parameters in
the Reference for Oracle GoldenGate for Windows and UNIX and Administering Oracle
GoldenGate for Windows and UNIX describes how they function.

B.1 Commands with Options
The Oracle GoldenGate commands with the specified options are listed in the
following sections.

B.1.1 ADD EXTRACT Commands
For an explanation of the ADD EXTRACT command, see the Reference for Oracle
GoldenGate for Windows and UNIX.

ADD EXTRACT Command Oracle GoldenGate Studio Label

ADD EXTRACT 
Add Extract

SOURCEISTABLE 
Table

TRANLOG 
Transaction Log

INTEGRATED TRANLOG 
Integrated Capture Mode
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ADD EXTRACT Command Oracle GoldenGate Studio Label

VAM 
Vendor Access Module

EXTFILESOURCE 
Source File Name

EXTTRAILSOURCE 
Source Trail Name

VAMTRAILSOURCE 
VAM Trail Name

BEGINNOW 
Now

EXTSEQNO 
At Sequence Number

EXTRBA 
Relative Byte Address

EOF 
End of Log File

LSN 
LSN

EXTRBA 
Relative Byte Address

PAGE 
Page

ROw
ROW

SEQNO 
Sequence Number

SCN 
System Change Number

THREADS 
Threads

PASSIVE 
Passive

PARAMS 
Parameter File

Commands with Options
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ADD EXTRACT Command Oracle GoldenGate Studio Label

REPORT 
Report File

DESC 
Description

B.1.2 ADD REPLICAT Commands
For an explanation of the ADD REPLICAT command, see the Reference for Oracle
GoldenGate for Windows and UNIX.

ADD REPLICAT Options Oracle GoldenGate Studio Label

ADD REPLICAT 
Add Replicat

INTEGRATED 
Integrated

COORDINATED
Coordinated

MAXTHREADS
Max Threads

SPECIALRUN 
Special Run

EXTFILE 
Extract File

EXTTRAIL 
Extract Trail

BEGIN 
Begin

NOW 
Now

EXTSEQNO 
Sequence Number

EXTRBA
Relative Byte Address

CHECKPOINTTABLE 
Checkpoint Table

NODBCHECKPOINT 
No Checkpoint Table

Commands with Options
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ADD REPLICAT Options Oracle GoldenGate Studio Label

PARAMS 
Parameter File

REPORT 
Report File

DESC 
Description

B.1.3 ADD EXTTRAIL Command
For an explanation of the ADD EXTRAIL command, see the Reference for Oracle
GoldenGate for Windows and UNIX.

ADD EXTTRAIL Options Oracle GoldenGate Studio Label

ADD EXT TRAIL 
Add Extract Trail

EXTRACT 
Extract

MEGABYTES 
Megabytes

SEQNO 
Sequence Number

B.1.4 ADD RMTTRAIL Command
For an explanation of the ADD RMTTRAIL command, see the Reference for Oracle
GoldenGate for Windows and UNIX.

ADD RMTTRAIL Options Oracle GoldenGate Studio Label

ADD RMTTRAIL 
Add Remote Trail

EXTRACT 
Extract

MEGABYTES 
Megabytes

SEQNO 
Sequence Number

Commands with Options
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B.1.5 REGISTER EXTRACT Command
For an explanation of the REGISTER EXTRACT command, see the Reference for Oracle
GoldenGate for Windows and UNIX.

REGISTER EXTRACT Options Oracle GoldenGate Studio Label

REGISTER EXTRACT 
Register Extract

DATABASE 
Database

CONTAINER 
Container

ADD CONTAINER 
Add Container

DROP CONTAINER 
Drop Container

LOGRETENTION 
Log Retention

SCN 
System Change Number

B.1.6 START EXTRACT Command
For an explanation of the START EXTRACT command, see the Reference for Oracle
GoldenGate for Windows and UNIX.

Start Extract Command Oracle GoldenGate Studio Label

START EXTRACT 
Start Extract

ATCSN 
At CSN

AFTERCSN 
After CSN

B.1.7 START REPLICAT Command
For an explanation of the START REPLICAT command, see the Reference for Oracle
GoldenGate for Windows and UNIX.

Commands with Options
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Start Replicat Command Oracle GoldenGate Studio Label

START REPLICAT 
Start Replicat

SKIPTRANSACTION 
Skip Transaction

ATCSN
At CSN

AFTERCSN
After CSN

FILTERDUPTRANSACTIONS 
Filter duplicate Transactions

THREADS 
Threads

B.1.8 ADD TRANDATA Command
For an explanation of the Trandata commands, see the Reference for Oracle GoldenGate
for Windows and UNIX.

Add Supplemental Logging Command Oracle GoldenGate Studio Label

ADD SCHEMATRANDATA
Enable Schema Supplemental Logging

ALLCOLS 
Logging Columns

ALLOWNONVALIDATEDKEYS
Allow Non-Validated Keys

ADD TRANDATA 
Enable Table Supplemental Logging

COLS 
Logging Columns

NOKEY 
Suppress primary key columns

INCLUDELONG 
Include LONGVAR columns

EXCLUDELONG 
Exclude LONGVAR columns

Commands with Options
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B.2 Parameter Category Names

Option

Add Extract Options

Add Replicat Options

Extract Registration

Globals

General

Environment Variables

Port Management

Process Management

Event Management

Maintenance

Processing Method

Selection, Converting and Mapping Data

Routing Data

Formatting Data

Custom Processing

Reporting

Tuning

Error Handling

Rep Error

Security

Other

Advanced

Start Extract Options

Start Replicat Options

Supplemental Logging

For more information parameter categories, see the Oracle GoldenGate Reference
Guide.

Parameter Category Names
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B.3 Units of Measure

Unit Option

MS 
Millisecond

CS 
Centisecond

CSEC 
Centisecond

CSECS 
Centiseconds

S 
Second

SEC 
Second

SECOND 
Second

SECS 
Seconds

SECONDS 
Seconds

M 
Minute

MIN 
Minute

MINUTE 
Minute

MINS 
Minutes

MINUTES 
Minutes

H 
Hour

HR 
Hour

Units of Measure
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Unit Option

HOUR 
Hour

HOURS 
Hours

D 
Day

DAY 
Day

DAYS 
Days

WEEK 
Week

WEEKS 
Weeks

K 
Kilobyte

KB 
Kilobyte

MB 
Megabyte

G 
Gigabyte

GB 
Gigabyte

B.4 Opposites

Oracle GoldenGate Parameters/Options Oracle GoldenGate Studio Label

batchsql.nobatcherrormode 
No Batch Error Mode

batchsql.nobypasspkcheck 
Don't Bypass PK Check

batchsql.nocheckuniquekeys 
Don't Check Unique Keys

Opposites
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Oracle GoldenGate Parameters/Options Oracle GoldenGate Studio Label

batchsql.noerrorhandling 
No Error Handling

bulkload.nologging 
Disable Redo Logging

bulkload.noparallel 
Disable Parallel Loading

dboptions.noallowlobdatatruncate 
Disallow LOB Truncation

dboptions.noallowunusedcolumn 
Disallow Unused Columns

dboptions.nocatalogconnect 
No Separate Catalog Connection

dboptions.nofetchlobs 
Disallow LOB Fetching

dboptions.nolimitrows 
Don't Limit Rows

dboptions.noreparselobsql 
Don't Reparse LOB SQL

dboptions.noshowwarnings 
Don't Log Warnings

dboptions.noskiptemplob 
Don't Skip Temp LOB

dboptions.nospthread 
No Separate Connection For Stored
Procedures

dboptions.nosuppresstriggers 
Don't Suppress Triggers

ddloptions.CROSSRENAME 
Cross Rename

ddloptions.ignoreapplops 
Ignore Application Operations

ddloptions.ignorereplicates 
Ignore Replicat Transactions

ddloptions.nomapderived 
Disallow Derived Name Mapping

Opposites
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Oracle GoldenGate Parameters/Options Oracle GoldenGate Studio Label

ddloptions.noreplicatepassword 
Don't Replicate Password

ddloptions.noreport 
Don't Log DDL Operations To Report File

disableheartbeat 
Disable Heartbeat

disableheartbeattable 
Disable Heartbeat Table

disablenewmanager 
Disable New Manager

extfile.no_objectdefs 
No Object Definitions

exttrail.no_objectdefs 
No Object Definitions

fetchoptions.nodetaileddiagnostics 
No Detailed Diagnostics

fetchoptions.nodiagnosticsonall 
No Diagnostics On All

fetchoptions.nousediagnostics 
Don't Use Diagnostics

fetchoptions.nousekey 
Don't Use Key

fetchoptions.nouselatestversion 
Don't Use Latest Version

fetchoptions.nouserowid 
Don't Use Row ID

fetchoptions.nousesnapshot 
Don't Use Snapshot

fetchoptions.suppressduplicates 
Suppress Duplicates

formatascii._noind 
No Ind

formatascii._noop 
No Op

Opposites
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Oracle GoldenGate Parameters/Options Oracle GoldenGate Studio Label

formatascii._nots 
No TS

formatascii.nonames 
Exclude Column Names

formatxml.noinlineproperties 
Write Properties Outside XML Tab

formatxml.notrans 
Exclude Commit Markers

ignorealters 
Ignore Alters

ignoreapplops 
Ignore Application Operations

ignorecreates 
Ignore Creates

ignoredeletes 
Ignore Deletes

ignoredrops 
Ignore Drops

ignoreinserts 
Ignore Inserts

ignorereplicates 
Ignore Replicat Transactions

ignoretruncates 
Ignore Truncates

ignoreupdateafters 
Ignore Update After Images

ignoreupdatebefores 
Ignore Update Before Images

ignoreupdates 
Ignore Updates

map.nohandlecollisions 
Don't Handle Collisions

map.noinsertappend 
Don't Insert Append

Opposites
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Oracle GoldenGate Parameters/Options Oracle GoldenGate Studio Label

map.noinsertmissingupdates 
Don't Insert Missing Updates

map.nomapinvisiblecolumns 
Don't Map Invisible Columns

map.notrimspaces 
Don't Trim CHAR to VARCHAR Trailing
Spaces

map.notrimvarspaces 
Don't Trim VARCHAR to CHAR Trailing
Spaces

no_use_traildefs 
Don't Use Trail Definitions

noallowduptargetmap 
Don't Allow Duplicate Target Map

noallowlargefloat 
Don't Allow Large Float

noallownoopupdates 
Don't Allow No-Operation Updates

noapplynoopupdates 
Don't Apply No-Operation Updates

noassumetargetdefs 
Don't Assume Target Definitions

noauditreps 
Don't Audit Replicats

nobinarychars 
Don't Use Binary Characters

nocachenullablecols 
Don't Cache Nullable Columns

nocharsetconversion 
Disable Character Set Conversion

nochecksequencevalue 
Don't Check Sequence Values

nocomplexnullcond 
No Complex Null Conditions

nocompressdeletes 
No Compress Deletes

Opposites
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Oracle GoldenGate Parameters/Options Oracle GoldenGate Studio Label

nocompressupdates 
No Compress Updates

nodeletelogrecs 
Don't Delete Log Records

nodynamicresolution 
No Dynamic Resolution

nodynsql 
No Dynamic SQL

nofilterdups 
Don't Filter Duplicates

nohandlecollisions 
Don't Handle Collisions

noinsertappend 
No Insert Append

noinsertdeletes 
Don't Insert Deletes

noinsertmissingupdates 
Don't Convert Failed Updates To Inserts

noinsertupdates 
Don't Insert Updates

nolist 
Don't List Parameters in Report File

nologallsupcols 
Don't Capture All Supplementally Logged
Columns

nomapinvisiblecolumns 
Don't Map Invisible Columns

nooverridedups 
Don't Override Duplicates

nopassthru 
Disable PassThru

nopassthrumessages 
Disable PassThru Messages

norestartcollisions 
Don't Restart Collisions

Opposites
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Oracle GoldenGate Parameters/Options Oracle GoldenGate Studio Label

nospacestonull 
Don't Convert Spaces to Null

notcpsourcetimer 
Do Not Compensate For System Clock
Differences

notrimspaces 
Don't Trim CHAR to VARCHAR Spaces

notrimvarspaces 
Don't Trim VARCHAR to CHAR Spaces

noupdatedeletes 
Don't Convert Deletes To Updates

noupdateinserts 
Don't Convert Inserts To Deletes

nouseansisqlquotes 
Don't Use ANSI SQL Quotes

nousededicatedcoordinationthread 
Don't Use Dedicated Coordination Thread

novarwidthnchar 
Don't Treat NCHAR, NVARCHAR2,
NCLOB As UTF-16

purgeoldextracts.no_use_checkpoints 
Don't Use Checkpoints

reportcount.norate 
Don't Report Rate

rmtfile.no_objectdefs 
No Object Definitions

rmttrail.no_objectdefs 
No Object Definitions

showsyntax.apply 
Apply

statoptions.noreportdetail 
No Operation Statistics

statoptions.noreportfetch 
Don't Fetch Statistics

statoptions.noresetreportstats 
Don't Reset Report Statistics

Opposites
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Oracle GoldenGate Parameters/Options Oracle GoldenGate Studio Label

table.notrimspaces 
Don't Trim CHAR to VARCHAR Spaces

table.notrimvarspaces 
Don't Trim VARCHAR to CHAR Spaces

trail_seqlen_6d 
Trail Sequence Length 6 digits

tranlogoptions._noarchivedlogonly 
Don't Read Only From Archived Logs

tranlogoptions.ignoremetadatafromvam 
Ignore Metadata From VAM

tranlogoptions.noapifilter 
No API Filter

tranlogoptions.nocompletearchivedlogonly 
No Complete Archived Log

tranlogoptions.nogetctasdml 
Don't Get CTAS DML

tranlogoptions.nomanagesecondarytruncationp
oint 

Manage Secondary Truncation Point

tranlogoptions.nominefromactivedg 
Don't Mine From Active Data Guard

tranlogoptions.nominefromsnapshotstby 
Don't Mine From Standby Snapshots

tranlogoptions.noprepareforupgradetoie 
Don't Prepare For Upgrade To Integrated
Extract

tranlogoptions.nopurgeorphanedtransactions 
Don't Purge Orphaned Transactions

tranlogoptions.nousenativeobjsupport 
Don't Use Native Object Support

tranlogoptions.nouseprevresetlogsid 
Don't Use Previous Reset Log SID

tranlogoptions.nouserexit 
No Userexit

Opposites
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B.5 Other Oracle GoldenGate Parameters/Options

Oracle GoldenGate Parameter/Option Oracle GoldenGate Studio Label

a2e 
ASCII to EBCDIC

accessrule 
Access Rule

allocfiles 
Allocate Memory Structures

allowduptargetmap 
Allow Duplicate Target Map

allowinvisibleindexkeys 
Allow Invisible Index Keys

allowlargefloat 
Allow Large Float

allownonvalidatedkeys 
Allow Non-Validated Keys

allownoopupdates 
Allow No-Operation Updates

allowoutputdir 
Allow Output Directory

applynoopupdates 
Apply No-Operation Updates

asciimixedccsid 
ASCII Mixed CCSID

asciitoebcdic 
ASCII to EBCDIC

assumetargetdefs 
Assume Target Definitions

assumetargetdefs.override 
Override Target Defs

auditreps 
Audit Replicats

autorestart 
Auto Restart
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autorestart.er 
Extract/Replicat

autorestart.extract 
Extract

autorestart.replicat 
Replicat

autorestart.resetminutes 
Reset Time (mins)

autorestart.retries 
Retries

autorestart.waitminutes 
Wait Time (mins)

autorestartinterval 
Auto Restart Interval

autorestartmintime 
Auto Restart Minimum Time

autostart 
AutoStart

autostart.er 
Extract/Replicat

autostart.extract 
Extract

autostart.replicat 
Replicat

batchsql 
BatchSQL

batchsql.batcherrormode 
Batch Error Mode

batchsql.batchesperqueue 
Batches Per Queue

batchsql.batchtransops 
Operations Per Transaction

batchsql.bypasspkcheck 
Bypass PK Check
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batchsql.bytesperqueue 
Bytes Per Queue

batchsql.checkuniquekeys 
Check Unique Keys

batchsql.errorhandling 
Error Handling

batchsql.maxthreadqueuedepth 
Max Thread Queue Depth

batchsql.numthreads 
Number of Threads

batchsql.opsperbatch 
Operations Per Batch

batchsql.opsperqueue 
Operations Per Queue

batchsql.thread 
Thread

batchsql.trace 
Trace

begin 
Begin

binarychars 
Binary Characters

bootdelayminutes 
Boot Delay (min)

bootdelayseconds 
Boot Delay (secs)

br 
Bounded Recovery

br.brdir 
Directory

br.brfsoption 
FS Option

br.brinterval 
Interval
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br.brkeepstalefiles 
Keep Stale Files

br.broff 
Off

br.broffonfailure 
Off On Failure

bulkload 
Bulk Load

bulkload.logging 
Log To Redo

bulkload.noskipallindexes 
Enable Index Maintenance

bulkload.parallel 
Enable Parallel Loading

bulkload.skipallindexes 
Skips Index Maintenance

bulkload.skipunusedindex 
Skip Unusable Indexes

cachemgr 
Cache Manager

cachemgr.cachebuffersize 
Cache Buffer Size

cachemgr.cachedirectory 
Cache Directory

cachemgr.cachefsoption 
Cache File Sync Option

cachemgr.cachepageoutsize 
Cache Page Outsize

cachemgr.cachesize 
Cache Size

cachenullablecols 
Cache Nullable Columns

catalogexclude 
Catalog Exclude
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catalogexclude.norename 
No Rename

cdroptions 
CDR Options

cdroptions.applymodcolonly 
Apply Modified Columns Only

charmap 
Character Map Override

charset 
Parameter File Character Set

charsetconversion 
Enable Character Set Conversion

checkminutes 
Maintenance Check Minutes

checkparams 
Check Parameter Syntax

checkpointsecs 
Checkpoint Seconds

checkpointtable 
Checkpoint Table

checksequencevalue 
Check Sequence Values

cmdtrace 
Command Trace

colmatch 
Column Match

colmatch.names 
Names

colmatch.prefix 
Prefix

colmatch.reset 
Reset

colmatch.suffix 
Suffix
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comment 
Comment

complexnullcond 
Complex Null Condition

compressdeletes 
Compress Deletes

compressdeletes.fetchmissingcolumns 
Fetch Missing Columns

compressupdates 
Compress Updates

coordstatinterval 
Coordinate Statistic Interval

coordtimer 
Coordinate Timer

credentialstorelocation 
Credential Store Location

cuserexit 
C User Exit

cuserexit.includeupdatebefores 
Include Update Before Images

cuserexit.params 
Params

cuserexit.passthru 
PassThru

dboptions 
Database Options

dboptions.allowlobdatatruncate 
Allow LOB Truncation

dboptions.allowunusedcolumn 
Allow Unused Columns

dboptions.bindcharforbitaschar 
Encode CCSID Data

dboptions.catalogconnect 
Use Separate Catalog Connection
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dboptions.catalogur 
Catalog Uncommit Read

dboptions.connectionport 
Connection Port

dboptions.decryptpassword 
Decrypt Password

dboptions.decryptpassword.algorithm 
Algorithm

dboptions.decryptpassword.aes128 
AES128

dboptions.decryptpassword.aes192 
AES192

dboptions.decryptpassword.aes256 
AES256

dboptions.decryptpassword.blowfish 
Blowfish

dboptions.decryptpassword.encryptkey 
Encryption Key

dboptions.deferrefconst 
Defer Referential Integrity Constraint

dboptions.disablecommitnowait 
Disable Asynchronous Commits

dboptions.disablelobcaching 
Disable LOB Caching

dboptions.emptylobstring 
Empty LOB String

dboptions.enableinstantiationfiltering 
Enable InstantiationCSN Filtering

dboptions.fetchbatchsize 
Fetch Batch Size

dboptions.fetchcheckfreq 
Fetch Check Freq

dboptions.fetchlobs 
Fetch LOBs
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dboptions.fetchretrycount 
Fetch Retry Count

dboptions.fetchtimeout 
Fetch Timeout

dboptions.host 
Host

dboptions.integratedparams 
Integrated Parameters

dboptions.integratedparams.ALLOW_DUPLICATE_
ROWS 

Allow Duplicate Rows

dboptions.integratedparams.APPLY_SEQUENCE_N
EXTVAL 

Apply Sequence Next Value

dboptions.integratedparams.BATCHSQL_MODE 
Batch SQL Mode

dboptions.integratedparams.CDGRANULARITY 
Conflict Detection Granularity

dboptions.integratedparams.COMMIT_SERIALIZA
TION 

Commit Serialization

dboptions.integratedparams.COMPARE_KEY_ONLY 
Compare Key Only

dboptions.integratedparams.COMPUTE_LCR_DEP_
ON_ARRIVAL 

Compute LCR Dependency On Arrival

dboptions.integratedparams.DISABLE_ON_ERROR 
Disable On Error

dboptions.integratedparams.DISABLE_ON_LIMIT 
Disable On Limit

dboptions.integratedparams.EAGER_SIZE 
Eager Size

dboptions.integratedparams.ENABLE_XSTREAM_T
ABLE_STATS 

Enable Table Statistics

dboptions.integratedparams.GROUPTRANSOPS 
Group Transaction Operations
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dboptions.integratedparams.HANDLECOLLISIONS 
Handle Collisions

dboptions.integratedparams.IGNORE_TRANSACTI
ON 

Ignore Transaction

dboptions.integratedparams.MAXIMUM_SCN 
Max SCN

dboptions.integratedparams.MAX_PARALLELISM 
Max Parallelism

dboptions.integratedparams.MAX_SGA_SIZE 
Max SGA Size

dboptions.integratedparams.MESSAGE_TRACKING
_FREQUENCY 

Message Tracking Frequency

dboptions.integratedparams.OPTIMIZE_PROGRES
S_TABLE 

Optimize Progress Table

dboptions.integratedparams.OPTIMIZE_SELF_UP
DATES 

Optimize Self Updates

dboptions.integratedparams.PARALLELISM 
Parallelism

dboptions.integratedparams.PARALLELISM_INTE
RVAL 

Parallelism Interval

dboptions.integratedparams.PRESERVE_ENCRYPT
ION 

Preserve Encryption

dboptions.integratedparams.RTRIM_ON_IMPLICI
T_CONVERSION 

RTRIM On Implicit Conversion

dboptions.integratedparams.STARTUP_SECONDS 
Startup Seconds

dboptions.integratedparams.SUPPRESSTRIGGERS 
Suppress Triggers

dboptions.integratedparams.TIME_LIMIT 
Time Limit
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dboptions.integratedparams.TRACE_LEVEL 
Trace Level

dboptions.integratedparams.TRANSACTION_LIMI
T 

Transaction Limit

dboptions.integratedparams.WRITE_ALERT_LOG 
Write Alert Log

dboptions.legacylobreplication 
Legacy LOB Replication

dboptions.limitrows 
Limit Rows

dboptions.lobbufsize 
LOB Buffer Size

dboptions.lobwritesize 
LOB Write Size

dboptions.nofetchtimeout 
No Fetch Timeout

dboptions.reparselobsql 
Reparse LOB SQL

dboptions.sessionpoolincr 
Session Pool Increase

dboptions.sessionpoolmax 
Session Pool Max

dboptions.sessionpoolmin 
Session Pool Min

dboptions.settag 
Set Tag

dboptions.showinfomessages 
Show Info Messages

dboptions.showwarnings 
Show Warnings

dboptions.skiptemplob 
Skip Temp LOB

dboptions.sourcedbname 
Source DB Name
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dboptions.sourcerootname 
Source CDB Root Name

dboptions.spthread 
SP Thread

dboptions.suppresstemporalupdates 
Edit Temporal Updates

dboptions.suppresstriggers 
Suppress Triggers

dboptions.tdspacketsize 
TDS Packet Size

dboptions.trustedconnection 
Trusted Connection

dboptions.useodbc 
Use ODBC

dboptions.usereplicationuser 
Use Replication User

dboptions.xmlbufsize 
XML Buffer Size

ddl 
DDL Operations

ddl.exclude 
Exclude

ddl.exclude.all 
All

ddl.exclude.allcatalogs 
All Catalogs

ddl.exclude.allowemptyobject 
Allow Empty Object

ddl.exclude.allowemptyowner 
Allow Empty Owner

ddl.exclude.eventactions 
EventActions

ddl.exclude.instr 
Instring
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ddl.exclude.instrcomments 
Instring Comments

ddl.exclude.instrcommentswords 
Instring Comments Words

ddl.exclude.instrwords 
Instring Words

ddl.exclude.mapped 
Mapped

ddl.exclude.objname 
Object Name

ddl.exclude.objtype 
Object Type

ddl.exclude.optype 
Operation Type

ddl.exclude.other 
Other

ddl.exclude.sourcecatalog 
Source Catalog

ddl.exclude.staymetadata 
Stay Metadata

ddl.exclude.unmapped 
Unmapped

ddl.include 
Include

ddl.include.all 
All

ddl.include.allcatalogs 
All Catalogs

ddl.include.allowemptyobject 
Allow Empty Object

ddl.include.allowemptyowner 
Allow Empty Owner

ddl.include.eventactions 
EventActions
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ddl.include.instr 
Instring

ddl.include.instrcomments 
Instring Comments

ddl.include.instrcommentswords 
Instring Comment Words

ddl.include.instrwords 
Instring Words

ddl.include.mapped 
Mapped

ddl.include.objname 
Object Name

ddl.include.objtype 
Object Type

ddl.include.optype 
Operation Type

ddl.include.other 
Other

ddl.include.sourcecatalog 
Source Catalog

ddl.include.staymetadata 
Stay Metadata

ddl.include.unmapped 
Unmapped

ddlerror 
DDL Error

ddlerror.abendmissingobjects 
Abend on Missing Objects

ddlerror.abendmissingtables 
Abend on Missing Tables

ddlerror.error_code 
Error Code

ddlerror.error_code.abend 
Abend
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ddlerror.error_code.discard 
Discard

ddlerror.error_code.exclude 
Exclude

ddlerror.error_code.exclude.all 
All

ddlerror.error_code.exclude.allcatalogs 
All Catalogs

ddlerror.error_code.exclude.allowemptyobjec
t 

Allow Empty Object

ddlerror.error_code.exclude.allowemptyowner 
Allow Empty Owner

ddlerror.error_code.exclude.eventactions 
Event Actions

ddlerror.error_code.exclude.instr 
Instring

ddlerror.error_code.exclude.instrcomments 
Instring Comments

ddlerror.error_code.exclude.instrcommentswo
rds 

Instruction Comments Words

ddlerror.error_code.exclude.instrwords 
Instruction Words

ddlerror.error_code.exclude.mapped 
Mapped

ddlerror.error_code.exclude.objname 
Object Name

ddlerror.error_code.exclude.objtype 
Object Type

ddlerror.error_code.exclude.optype 
Operation Type

ddlerror.error_code.exclude.other 
Other

ddlerror.error_code.exclude.sourcecatalog 
Source Catalog
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ddlerror.error_code.exclude.staymetadata 
Stay Metadata

ddlerror.error_code.exclude.unmapped 
Unmapped

ddlerror.error_code.ignore 
Ignore

ddlerror.error_code.include 
Include

ddlerror.error_code.include.all 
All

ddlerror.error_code.include.allcatalogs 
All Catalogs

ddlerror.error_code.include.allowemptyobjec
t 

Allow Empty Object

ddlerror.error_code.include.allowemptyowner 
Allow Empty Owner

ddlerror.error_code.include.eventactions 
Event Actions

ddlerror.error_code.include.instr 
Instring

ddlerror.error_code.include.instrcomments 
Instring Comments

ddlerror.error_code.include.instrcommentswo
rds 

Instruction Comments Words

ddlerror.error_code.include.instrwords 
Instruction Words

ddlerror.error_code.include.mapped 
Mapped

ddlerror.error_code.include.objname 
Object Name

ddlerror.error_code.include.objtype 
Object Type

ddlerror.error_code.include.optype 
Operation Type
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ddlerror.error_code.include.other 
Other

ddlerror.error_code.include.sourcecatalog 
Source Catalog

ddlerror.error_code.include.staymetadata 
Stay Metadata

ddlerror.error_code.include.unmapped 
Unmapped

ddlerror.error_code.retryop 
Retry Operation

ddlerror.error_code.retryop.maxretries 
Max Retries

ddlerror.error_code.retryop.retrydelay 
Retry Delay

ddlerror.ignoremissingobjects 
Ignore Missing Objects

ddlerror.ignoremissingtables 
Ignore Missing Tables

ddlerror.norestartcollisions 
Do Not Restart With HandleCollisions

ddlerror.restartcollisions 
Restart With HandleCollisions

ddlerror.restartskip 
Restart And Skip

ddlerror.skiptriggererror 
Skip Trigger Error

ddloptions 
DDL Options

ddloptions.NOADDTRANDATA 
No Add Trandata

ddloptions.NOCAPTUREGLOBALTEMPTABLE 
No Capture Global Temp Table

ddloptions.NOCROSSRENAME 
No Cross Rename
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ddloptions.USEPASSWORDVERIFIERLEVEL 
Use Password Verifier Level

ddloptions.addtrandata 
Add Trandata

ddloptions.addtrandata.abend 
Abend

ddloptions.addtrandata.retryop 
Retry Operation

ddloptions.addtrandata.retryop.maxretries 
Max Retries

ddloptions.addtrandata.retryop.retrydelay 
Retry Delay

ddloptions.captureglobaltemptable 
Capture Global Template

ddloptions.defaultuserpassword 
Default User Password

ddloptions.defaultuserpassword.aes128 
AES128

ddloptions.defaultuserpassword.aes192 
AES192

ddloptions.defaultuserpassword.aes256 
AES256

ddloptions.defaultuserpassword.blowfish 
Blowfish

ddloptions.defaultuserpassword.encryptkey 
Encrypt Key

ddloptions.defaultuserpasswordalias 
Default User Password Alias

ddloptions.defaultuserpasswordalias.domain 
Domain

ddloptions.getapplops 
Get Application Operations

ddloptions.getreplicates 
Get Replicat Transactions

Other Oracle GoldenGate Parameters/Options

Relating Properties Inspector Options to Oracle GoldenGate Commands and Parameters  B-33



Oracle GoldenGate Parameter/Option Oracle GoldenGate Studio Label

ddloptions.ignoremapping 
Ignore Mapping

ddloptions.mapderived 
Map Derived

ddloptions.mapschemas 
Map Schemas

ddloptions.mapsessionschema 
Map Session Schema

ddloptions.noremovecomments 
Don't Remove Comments

ddloptions.notag 
No Tag

ddloptions.password 
Password

ddloptions.password.aes128 
AES128

ddloptions.password.aes192 
AES192

ddloptions.password.aes256 
AES256

ddloptions.password.blowfish 
Blowfish

ddloptions.password.encryptkey 
Encryption Key

ddloptions.removecomments 
Remove Comments

ddloptions.replicatepassword 
Replicate Password

ddloptions.report 
Log DDL Operations To Report File

ddloptions.target 
Target

ddloptions.updatemetadata 
Update Metadata
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ddloptions.useownerforsession 
Use Owner for Session

ddlrulehint 
DDL Rule Hint

ddlsubst 
DDL Substitution

ddlsubst.allcatalogs 
All Catalogs

ddlsubst.allowemptyobject 
Allow Empty Object

ddlsubst.allowemptyowner 
Allow Empty Owner

ddlsubst.eventactions 
Event Actions

ddlsubst.exclude 
Exclude

ddlsubst.exclude.all 
All

ddlsubst.exclude.mapped 
Mapped

ddlsubst.exclude.other 
Other

ddlsubst.exclude.unmapped 
Unmapped

ddlsubst.include 
Include

ddlsubst.include.all 
All

ddlsubst.include.mapped 
Mapped

ddlsubst.include.other 
Other

ddlsubst.include.unmapped 
Unmapped
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ddlsubst.instr 
Apply to String

ddlsubst.instrcomments 
Comments

ddlsubst.instrcommentswords 
Comment Words

ddlsubst.instrwords 
Apply to Instructions

ddlsubst.objname 
Object Name

ddlsubst.objtype 
DB Object Type

ddlsubst.optype 
DDL Operation Type

ddlsubst.sourcecatalog 
Source Catalog

ddlsubst.staymetadata 
Stay metadata

ddlsubst.with 
With

ddltable 
DDL Table Name Override

decrypttrail 
Decrypt Trail

decrypttrail.algorithm 
Algorithm

decrypttrail.aes128 
AES128

decrypttrail.aes192 
AES192

decrypttrail.aes256 
AES256

decrypttrail.keyname 
Key Name
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deferapplyinterval 
Defer Apply Interval

defsfile 
DEFGEN Definition File

defsfile.append 
Append

defsfile.charset 
Character Set

defsfile.format 
Format Release

defsfile.format.level 
Level

defsfile.format.release 
Release

defsfile.purge 
Purge

deletelogrecs 
Delete Log Records

discardfile 
Discard File

discardfile.append 
Append

discardfile.maxbytes 
Max Bytes

discardfile.megabytes 
Megabytes

discardfile.purge 
Purge

discardrollover 
Discard Rollover

discardrollover.at 
At

discardrollover.on 
On
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downcritical 
Down Critical

downinfo 
Down Info

downreporthours 
Down Report Hours

downreportminutes 
Down Report Minutes

dsoptions 
Teradata Data Server Options

dsoptions.checkopcomplete 
Check Op Complete

dsoptions.checktrandata 
Check Trandata

dsoptions.committedtranlog 
Committed Tranlog

dsoptions.createtranlog 
Create Tranlog

dsoptions.excludetrans 
Exclude Tranlog

dsoptions.excludeuser 
Exclude User

dsoptions.excludeuserid 
Exclude User ID

dsoptions.ignoremetadatafromvam 
Ignore VAM Metadata

dsoptions.restartappend 
Restart Append

dsoptions.sorttranlog 
Sort Tranlog

dsoptions.vamcompatibility 
VAM Compatibility

dumpddlcolumns 
Dump DDL Columns
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dumpddlloggroups 
Dump DDL Log Groups

dumpddlobjects 
Dump DDL Objects

dumpddlpartitions 
Dump DDL Partitions

dumpddlprimarykeys 
Dump DDL Primary Keys

dynamicportlist 
Dynamic Port List

dynamicportreassigndelay 
Dynamic Port Reassign Delay

dynamicresolution 
Dynamic Resolution

dynsql 
Dynamic SQL

ebcdicmixedccsid 
EBCDIC Mixed CCSID

ebcdictoascii 
EBCDIC to ASCII

enablecatalognames 
Enable Catalog Names

enableheartbeat 
Enable Heartbeat

enablemonitoring 
Enable Monitoring

enablemonitoring.bdb 
BDB (Berkeley DB)

enablemonitoring.lmdb 
LMDB (Lightning DB)

enablemonitoring.shmid 
SHMID (Shared Memory ID)

enablenewmanager 
Enable New Manager
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encrypttrail.0 
Encrypt Trail

encrypttrail.1
Algorithm

encrypttrail.keyname 
Key Name

end 
End

eofdelay 
EOF Delay (seconds)

eofdelaycsecs 
EOF Delay (centiseconds)

etoldformat 
ET Old Format

excludetag 
Exclude Tag

excludewildcardobjectsonly 
Exclude Wildcard Objects Only

extfile 
Extract File

extfile.format 
Format Release

extfile.level 
Format Level

extfile.maxfiles 
Max Files

extfile.megabytes 
Megabytes

extfile.objectdefs
Object Definitions

extfile.purge
Purge

extfile.release
Release
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extfile.trailbyteorder 
Trail Byte Order

extract
Extract

exttrail
Trail

exttrail.format 
Format Release

exttrail.level 
Format Level

exttrail.objectdefs 
Object Definitions

exttrail.release 
Format Release

exttrail.trailbyteorder 
Trail Byte Order

fetchoptions 
Fetch Options

fetchoptions.detaileddiagnostics 
Detailed Diagnostics

fetchoptions.diagnosticsonall 
Diagnostics On All

fetchoptions.fetchpkupdatecols 
Fetch PK Updates Columns

fetchoptions.inconsistentrow 
Inconsistent Row

fetchoptions.maxfetchstatements 
Max Fetch Statements

fetchoptions.missingrow 
Missing Row

fetchoptions.nofetch 
No Fetch

fetchoptions.nosuppressduplicates 
No Suppress Duplicates
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fetchoptions.usediagnostics 
Use Diagnostics

fetchoptions.usekey 
Use Key

fetchoptions.uselatestversion 
Use Latest Version

fetchoptions.userowid 
Use Row ID

fetchoptions.usesnapshot 
Use Snapshot

fetchuserid 
Fetch User ID

fetchuserid.algorithm 
Algorithm

fetchuserid.encryptkey 
Encrypt Key

fetchuserid.password 
Password

fetchuserid.sysdba 
Sysdba

filterdups 
Filter Duplicates

flushcsecs 
Flush Memory Buffer (csecs)

flushsecs 
Flush (secs)

formatascii 
Format ASCII

formatascii.bcp 
MSSQL Bulk Load

formatascii.charset 
Character Set

formatascii.date 
Date Time Format
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formatascii.delimiter 
Delimiter

formatascii.extracols 
Extra Columns

formatascii.ind 
Include Before and After Ind

formatascii.names 
Include Columns Names

formatascii.nohdrfields 
Suppress Header Fields

formatascii.noquote 
Exclude Quotes

formatascii.nullisspace 
Convert Null to Blank

formatascii.op 
Include Operation Type

formatascii.placeholders 
Placeholders

formatascii.sqlloader 
Oracle SQL Loader

formatascii.time 
Time

formatascii.ts 
Timestamp

formatsql 
Write SQL Format File

formatsql.nonames 
Omit Column Names

formatsql.nopkupdates 
No PK Updates

formatsql.oracle 
Oracle Date-Times

formatxml 
Format XML
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formatxml.encoding 
Encoding

formatxml.inlineproperties 
Write Properties Inline With XML Tab

formatxml.trans 
Include Commit Markers

functionstacksize 
Function Stack Size

genloadfiles 
Generate Load Files

genloadfiles.charset 
Character Set

getalters 
Get Alters

getapplops 
Get Application Operations

getcreates 
Get Creates

getdeletes 
Get Deletes

getdrops 
Get Drops

getenv 
Get Environment

getinserts 
Get Inserts

getreplicates 
Get Replicat Transactions

gettruncates 
Get Truncates

getupdateafters 
Get Update After Images

getupdatebefores 
Get Updates Before Images
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getupdates 
Get Updates

ggschema 
Schema Name

grouptransops 
Group Transaction Operations

handlecollisions 
Handle Collisions

handlecollisions.thread 
Threads

handletpkupdate 
Handle Transient Primary-Key Update

haveudtwithnchar 
User Data Type Contains NCHAR

heartbeat_table 
Heartbeat Table

ignore_unrecognized 
Ignore Unrecognized

include 
Include

initializeheap 
Initialize Heap

insertallrecords 
Insert All Records

insertappend 
Insert Append

insertdeletes 
Insert Deletes

insertmissingupdates 
Convert failed updates to inserts

insertupdates 
Insert Updates

jvmadditionalopts 
JVM Additional Options
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jvmclasspath 
JVM Classpath

jvmcompiler 
JVM Compiler

jvmentryclass 
JVM Entry Class

jvmentrymethod 
JVM Entry Method

jvmentrymethodarguments 
JVM Entry Method Arguments

jvmentrymethodsignature 
JVM Entry Method Signature

jvmlibrarypath 
JVM Library Path

lagcriticalhours 
Critical Hours Lag Threshold

lagcriticalminutes 
Critical Minutes Lag Threshold

lagcriticalseconds 
Critical Seconds Lag Threshold

laginfohours 
Info Hours Lag Threshold

laginfominutes 
Info Minutes Lag Threshold

laginfoseconds 
Lag Info Seconds

lagreporthours 
Report Hours Lag Threshold

lagreportminutes 
Report Minutes Lag Threshold

lfmmemory 
LFM (Long Field Memory)

lfmmemory.directory 
Directory
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lfmmemory.inittransram 
Init Trans RAM

lfmmemory.ram 
RAM

lfmmemory.ramincrement 
RAM Increment

lfmmemory.transallsources 
Trans All Sources

lfmmemory.transram 
Trans RAM

list 
List

lobmemory 
LOB Memory

lobmemory.directory 
Directory

lobmemory.inittransram 
Init Trans RAM

lobmemory.ram 
RAM

lobmemory.ramincrement 
RAM Increment

lobmemory.transallsources 
Trans All Sources

lobmemory.transram 
Trans RAM

logallsupcols 
Capture All Supplementally Logged
Columns

logfilesbehind 
Log Files Behind

logfilesbehindinfo 
Log Files Behind Message

macro 
Macro

Other Oracle GoldenGate Parameters/Options

Relating Properties Inspector Options to Oracle GoldenGate Commands and Parameters  B-47



Oracle GoldenGate Parameter/Option Oracle GoldenGate Studio Label

macro.begin 
Body

macro.params 
Parameters

macrochar 
Macro Character

mapexclude 
Map Exclude

mapexclude.norename 
No Rename

mapinvisiblecolumns 
Map Invisible Columns

mapinvisiblecolumns.thread 
Thread

markertable 
Marker Table

masterkeyname 
Master Key Name

masterkeyname.version 
Version

maxabendrestarts 
Max Abend Restarts

maxdiscardrecs 
Max Discard Records

maxetcheckptsecs 
Max Checkpoint Seconds

maxfetchstatements 
Max Fetch Statements

maxfieldlen 
Max Field Length

maxgroups 
Max Process Groups

maxsqlstatements 
Max SQL Statements
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maxtaclrestarts 
Max Tacl Restarts

maxtransops 
Max Transaction Operations

maxtraprestarts 
Max Trap Restarts

mgrservname 
Manager Server Name

monitoring_heartbeat_timeout 
Monitoring Heartbeat Timeout (secs)

nameccsid 
DB Name CCSID

namematchexact 
Exact Match

namematchignorecase 
Ignore Case

namematchnowarning 
No Name Match Warning

noasciiformat 
No ASCII Format

nocatalog 
Remove Catalog Name

nodiscardfile 
Disallow Discard File

nodupmsgsuppression 
Disallow Duplicate Message Suppression

noencrypttrail 
Disallow Encrypt Trail

nosqlformat 
No SQL Format

nostats 
Disable Performance Statistics

notracetable 
Disallow Trace Table
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nouserid 
No User ID

nousethreads 
Disallow Use Threads

numfiles 
Memory Structures Initial Number

obey 
Obey

outputfileumask 
Output File umask

overridedups 
Override Duplicates

param_parse_error 
Parameter Parsing Error

param_parse_error.force 
Force

passthru 
Enable PassThru

passthrumessages 
Enable PassThru Messages

port 
Port

preservetargettimezone 
Preserve Target Timezone

ptkcapturebatchsql 
Capture Batch SQL Statistics

ptkcapturecachemgr 
Capture Cache Statistics

ptkcaptureift 
Capture Inflight Transactions

ptkcapturenetwork 
Capture Network Statistics

ptkcaptureprocstats 
Enable Process/Thread Statistics
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ptkcapturequeuestats 
Capture Queue Statistics

ptkcapturetablestats 
Capture Table Statistics

ptkirstatsfrequency 
Statistics Frequency

ptkmaxtables 
Max Tables for Statistics

ptkmonitorfrequency 
Monitoring Collection Frequency (sec)

ptkspstats 
Capture Superpool Statistics

ptktablepollfrequency 
Poll Interval for Table Statistics

purgeddlhistory 
Purge DDL_HISTORY

purgeddlhistory.frequencyhours 
Frequency Hours

purgeddlhistory.frequencyminutes 
Frequency Minutes

purgeddlhistory.maxkeepdays 
Max Keep Days

purgeddlhistory.maxkeephours 
Max Keep Hours

purgeddlhistory.minkeepdays 
Minimum Keep Days

purgeddlhistory.minkeephours 
Minimum Keep Hours

purgeddlhistoryalt 
Purge DDL_HISTORY_ALT

purgeddlhistoryalt.frequencyhours 
Frequency Hours

purgeddlhistoryalt.frequencyminutes 
Frequency Minutes
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purgeddlhistoryalt.maxkeepdays 
Max Keep Days

purgeddlhistoryalt.maxkeephours 
Max Keep Hours

purgeddlhistoryalt.minkeepdays 
Minimum Keep Days

purgeddlhistoryalt.minkeephours 
Minimum Keep Hours

purgemarkerhistory 
Purge MARKER_HISTORY table

purgemarkerhistory.frequencyhours 
Frequency Hours

purgemarkerhistory.frequencyminutes 
Frequency Minutes

purgemarkerhistory.maxkeepdays 
Max Keep Days

purgemarkerhistory.maxkeephours 
Max Keep Hours

purgemarkerhistory.minkeepdays 
Minimum Keep Days

purgemarkerhistory.minkeephours 
Minimum Keep Hours

purgeoldextracts 
Purge Old Extracts

purgeoldextracts.frequencyhours 
Frequency Hours

purgeoldextracts.frequencyminutes 
Frequency Minutes

purgeoldextracts.maxkeepdays 
Max Keep Days

purgeoldextracts.maxkeepfiles 
Max Keep Files

purgeoldextracts.maxkeephours 
Max Keep Hours
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purgeoldextracts.minkeepdays 
Minimum Keep Days

purgeoldextracts.minkeepfiles 
Minimum Keep Files

purgeoldextracts.minkeephours 
Minimum Keep Hours

purgeoldextracts.usecheckpoints 
Use Checkpoints

purgeoldhistory 
Purge Old History

purgeoldhistory.maxkeepdays 
Max Keep Days

purgeoldhistory.maxkeephours 
Max Keep Hours

purgeoldhistory.minkeepdays 
Minimum Keep Days

purgeoldhistory.minkeephours 
Minimum Keep Hours

purgeoldtasks 
Purge Old Tasks

purgeoldtasks.after 
After

purgeoldtasks.er 
Extract/Replicat

purgeoldtasks.extract 
Extract

purgeoldtasks.replicat 
Replicat

purgeoldtasks.usestopstatus 
Use Top Status

randomrollbacks 
Random Rollbacks

recoveryoptions 
Recovery Options
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recoveryoptions.appendmode 
Append Mode

recoveryoptions.overwritemode 
Overwrite Mode

reperror 
Replicat Error

reperror.reset 
Reset

repfetchedcoloptions 
Replicat Fetched Column Options

repfetchedcoloptions.inconsistentrow 
Inconsistent Row

repfetchedcoloptions.latestrowversion 
Latest Row Version

repfetchedcoloptions.missingrow 
Missing Row

repfetchedcoloptions.nofetch 
Prevent Fetch

repfetchedcoloptions.redundantrow 
Redundant Row

repfetchedcoloptions.setifmissing 
Set If Missing

repfetchedcoloptions.snapshotrow 
Snapshot Row

replacebadchar 
Replaces Invalid Character

replacebadchar.abort 
Abort

replacebadchar.enablefallback 
Enable Fallback

replacebadchar.escape 
Escape

replacebadchar.forcecheck 
Force Check
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replacebadchar.nowarning 
No Warning

replacebadchar.null 
Null

replacebadchar.skip 
Skip

replacebadchar.space 
Space

replacebadchar.substitute 
Substitute

replacebadchar.unprintable 
Unprintable

replacebadnum 
Replace Invalid Numbers

replicat 
Replicat

repobackupdir 
Repository Backup Directory

repobackupfrequency 
Repository Backup Frequency

reponumbackupsbeforefullbackup 
Repository Backups Before Full Backup

report 
Report

report.AT 
At

report.ON 
On

reportcount 
Transaction Record Report Count

reportcount.every 
Every

reportcount.rate 
Report Rate
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reportformatnoremote 
Report Format No Remote

reportrollover 
Report Rollover

reportrollover.AT 
At

reportrollover.ON 
On

restartcollisions 
Restart Collisions

restartinterval 
Restart Interval

retrydelay 
Retry Delay

rmtfile 
Remote File

rmtfile.append 
Append

rmtfile.format 
Format Release

rmtfile.level 
Format Level

rmtfile.maxfiles 
Max Files

rmtfile.megabytes 
Megabytes

rmtfile.objectdefs 
Object Definitions

rmtfile.purge 
Purge

rmtfile.release 
Format Release

rmtfile.trailbyteorder 
Trail Byte Order
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rmthost 
Remote Host

rmthost.compress 
Compress

rmthost.compressthreshold 
Compress Threshold

rmthost.cpu 
CPU

rmthost.encrypt 
Encrypt

rmthost.hometerm 
Device

rmthost.keyname 
Key Name

rmthost.mgrport 
Manager Port

rmthost.nostreaming 
No Streaming

rmthost.params 
Parameters

rmthost.password 
Password

rmthost.port 
Collector Port

rmthost.pri 
Priority

rmthost.processname 
Process Name

rmthost.socksproxy 
Socks Proxy

rmthost.socksproxy.proxycsalias 
Proxy Credential Store Alias

rmthost.socksproxy.proxycsdomain 
Proxy Credential Store Domain
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rmthost.streaming 
Streaming

rmthost.tcpbufsize 
TCP Buffer Size

rmthost.tcpflushbytes 
TCP Flush Bytes

rmthost.timeout 
Timeout

rmthost.user 
User ID

rmthostoptions 
Remote Host Options

rmthostoptions.compress 
Compress

rmthostoptions.compressthreshold 
Compress Threshold

rmthostoptions.encrypt 
Encrypt

rmthostoptions.keyname 
Key Name

rmthostoptions.nostreaming 
No Streaming

rmthostoptions.params 
Parameters

rmthostoptions.streaming 
Streaming

rmthostoptions.tcpbufsize 
TCP Buffer Size

rmthostoptions.tcpflushbytes 
TCP Flush Bytes

rmthostoptions.timeout 
Timeout

rmttask 
Remote Task
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rmttask.format 
Format Release

rmttask.group 
Group

rmttask.level 
Format Level

rmttask.params 
Parameters

rmttask.release 
Format Release

rmttrail 
Remote Trail

rmttrail.format 
Format Release

rmttrail.level 
Format Level

rmttrail.objectdefs 
Object Definitions

rmttrail.release 
Format Release

rmttrail.trailbyteorder 
Trail Byte Order

rollover 
Rollover

rollover.at 
At

rollover.on 
On

rollover.report 
Report

schemaexclude 
Exclude Replicat Schema

schemaexclude.norename 
No Rename
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sequence 
Sequence

sessioncharset 
Session Character Set

setenv 
Set Environment

showsyntax 
Show SQL Syntax

showsyntax.all 
All

showsyntax.includelob 
Include LOB

showsyntax.noapply 
No Apply

sourcecatalog 
Source Catalog

sourcecharset 
Source Character Set

sourcecharset.character_set_name 
Character Set Name

sourcecharset.db2zos 
DB2 On z/OS

sourcecharset.override 
Override

sourcecharset.passthru 
PassThru

sourcedb 
Source DB

sourcedb.credentialgroup 
Credential Group

sourcedb.domain 
Domain

sourcedb.encryptkey 
Encrypt Key
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sourcedb.password 
Password

sourcedb.password.aes128 
AES128

sourcedb.password.aes192 
AES192

sourcedb.password.aes256 
AES256

sourcedb.password.blowfish 
Blowfish

sourcedb.sessioncharset 
Session Character Set

sourcedb.sqlid 

sourcedb.sysdba 
Sysdba

sourcedb.thread 
Threads

sourcedb.userid 
User ID

sourcedb.useridalias 
User Alias

sourcedefs 
Source Definitions

sourcedefs.override 
Override

sourceisfile 
Source Is File

sourceistable 
Source Is Table

sourcetimezone 
Source Timezone

spacestonull 
Convert Spaces to Null
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specialrun 
Special Run

sqlduperr 
SQL Duplicate Error

sqlexec 
SQL Execution

sqlexec.every 
Every

sqlexec.onexit 
On Exit

sqlexec.thread 
Thread

startupvalidationdelay 
Startup Validation Delay (secs)

startupvalidationdelaycsecs 
Startup Validation Delay (csecs)

statoptions 
Statistic Options

statoptions.reportcharconv 
Report Character Conversion

statoptions.reportdetail 
Operation Statistics

statoptions.reportfetch 
Fetch Statistics

statoptions.resetreportstats 
Reset Report Statistics

statoptions.thread 
Thread

syslog 
Sys Log

syslog.all 
All

syslog.error 
Error
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syslog.info 
Info

syslog.none 
None

syslog.warn 
Warning

tableexclude 
Exclude Table

tableexclude.norename 
No Rename

targetdb 
Target DB

targetdb.domain 
Domain

targetdb.dsn 
DSN

targetdb.encryptkey 
Encrypt Key

targetdb.libfile 
Library File

targetdb.password 
Password

targetdb.password.aes128 
AES128

targetdb.password.aes192 
AES192

targetdb.password.aes256 
AES256

targetdb.password.blowfish 
Blowfish

targetdb.sessioncharset 
Session Character Set

targetdb.set 
Set
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targetdb.sqlid 
SQL ID

targetdb.sysdba 
Sysdba

targetdb.thread 
Threads

targetdb.userid 
User ID

targetdb.useridalias 
User Alias

targetdefs 
Target Definitions

targetdefs.override 
Override

tcpsourcetimer 
Compensate For System Clock Differences

threadoptions 
Thread Options

threadoptions.eofdelaycsecs 
EOF Delay Centiseconds

threadoptions.eofdelayms 
EOF Delay (ms)

threadoptions.except 
Except

threadoptions.inqueuesize 
Input Queue Size

threadoptions.outqueuesize 
Output Queue Size

threadoptions.processthreads 
Process Threads

threadoptions.select 
Select

threadoptions.stacksize 
Stack Size
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tltrace 
Transaction Log Trace

tltrace.data 
Use Raw Format

tltrace.ddl 
DDL

tltrace.debug 
Debug

tltrace.file 
File

tltrace.level 
Level

tltrace.pause 
Pause

trace 
Trace

trace2 
Trace2

traceapi 
Trace API

tracetable.0 
Trace Table

tracetable.1 
Name

trail_seqlen_9d 
Trail Sequence Length 9 digits

trailbyteorder 
Trail Byte Order

trailcharset 
Trail Character Set

trailcharset.replacebadchar 
Replace Bad Character

trailcharsetascii 
Trail Character Set ASCII
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trailcharsetebcdic 
Trail Character Set EBCDIC

trailcharsetunicode 
Unicode Trail Character Set

tranlogoptions 
Transaction Log Options

tranlogoptions.USE_ROOT_CONTAINER_TIMEZONE 
Use Root Container Timezone

tranlogoptions._allowtablecompression 
Allow Table Compression

tranlogoptions.activationidpadlen 
Activation ID Pad Length

tranlogoptions.activesecondarytruncationpoi
nt 

Active Secondary Truncation

tranlogoptions.adgapplycheckfreq 
ADG Apply Check Frequency

tranlogoptions.adgretrycount 
ADG Retry Count

tranlogoptions.adgtimeout 
ADG Timeout

tranlogoptions.allowdataloss 
Allow Data Loss

tranlogoptions.allowtablecompression 
Allow Table Compression

tranlogoptions.altarchivedlogformat 
Alt Archive Log Format

tranlogoptions.altarchivelogdest 
Alt Archive Log Destination

tranlogoptions.altlogdest 
Alt Log Destination

tranlogoptions.altonlinelogs 
Alt Online Logs

tranlogoptions.apifilter 
API Filter
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tranlogoptions.archivedlogonly 
Archived Log Only

tranlogoptions.archiverestoreexecutable 
Archive Restore Executable

tranlogoptions.archiverestoreparams 
Archive Restore Parameters

tranlogoptions.asmbufsize 
ASM Buffer Size

tranlogoptions.asmuser 
ASM User

tranlogoptions.asmuser.aes128 
AES128

tranlogoptions.asmuser.aes192 
AES192

tranlogoptions.asmuser.aes256 
AES256

tranlogoptions.asmuser.asmpassword 
ASM Password

tranlogoptions.asmuser.blowfish 
Blowfish

tranlogoptions.asmuser.encryptkey 
Encrypt Key

tranlogoptions.asmuser.sysdba 
Sysdba

tranlogoptions.asmuseralias 
ASM User Alias

tranlogoptions.asmuseralias.domain 
Domain

tranlogoptions.asynctransprocessing 
Async Transaction Processing

tranlogoptions.bufsize 
Buffer Size

tranlogoptions.checkpointretentiontime 
Checkpoint Retention
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tranlogoptions.checkpointtable 
Checkpoint Table

tranlogoptions.checkposition 
Check Position

tranlogoptions.checktablelevelsupplog 
Checktable Level Suppl Log

tranlogoptions.completearchivedlogonly 
Complete Archived Log

tranlogoptions.completearchivedlogtimeout 
Complete Archived Log Timeout

tranlogoptions.convertucs2clobs 
Convert UCS to CLOBS

tranlogoptions.createtranlog 
Create Transaction Log

tranlogoptions.databaseidpadlen 
Database ID Pad Len

tranlogoptions.dblogreader 
DB Log Reader

tranlogoptions.dblogreaderbufsize 
DB Log Reader Buffer Size

tranlogoptions.excludetag 
Exclude Tag

tranlogoptions.excludetrans 
Exclude Transaction

tranlogoptions.excludeuser 
Exclude User

tranlogoptions.excludeuserid 
Exclude User ID

tranlogoptions.failovertargetdestid 
Failover Target Destination ID

tranlogoptions.fetchinlinesflob 
Fetch Inline FS Lob

tranlogoptions.fetchlobonerror 
Fetch LOB On Error
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tranlogoptions.fetchpartiallob 
Fetch Partial LOB

tranlogoptions.fetchpartialxml 
Fetch Partial XML

tranlogoptions.fetchxmlonerror 
Fetch XML On Error

tranlogoptions.filtertable 
Filter Table

tranlogoptions.flush 
Flush

tranlogoptions.forcefetchlob 
Force Fetch LOB

tranlogoptions.getctasdml 
Get CTAS DML

tranlogoptions.getmetadatafromvam 
Get Metadata From VAM

tranlogoptions.handledlfailover 
Handled Failover

tranlogoptions.iflockseconds 
If Lock (secs)

tranlogoptions.ignoredatacapturechanges 
Ignore Data Capture Changes

tranlogoptions.ignoredirectloadinserts 
Ignore Direct Load Inserts

tranlogoptions.ignoregap 
Ignore Gap

tranlogoptions.ignorekeyerror 
Ignore Key Error

tranlogoptions.includeaux 
Include AUX

tranlogoptions.includeregionid 
Include Region ID

tranlogoptions.includeregionidwithoffset 
Include Region ID With Offset
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tranlogoptions.integratedparams 
Integrated Parameters

tranlogoptions.legacylobreading 
Legacy LOB Reading

tranlogoptions.logretention 
Log Retention

tranlogoptions.logretention.days 
Days

tranlogoptions.logsource 
Log Source

tranlogoptions.logswitchmsg 
Log Switch Message

tranlogoptions.managesecondarytruncationpoi
nt 

Manage Secondary Truncation Point

tranlogoptions.maxparallelrec 
Max Parallel Records

tranlogoptions.maxreadsize 
Max Read Size

tranlogoptions.maxwarneof 
Max Warn EOF

tranlogoptions.minefromactivedg 
Mine From Active DG

tranlogoptions.minefromsnapshotstby 
Mine From Snapshots

tranlogoptions.mininguser 
Mining User

tranlogoptions.mininguser.algorithm 
Algorithm

tranlogoptions.mininguser.aes128 
AES128

tranlogoptions.mininguser.aes192 
AES192

tranlogoptions.mininguser.aes256 
AES256
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tranlogoptions.mininguser.blowfish 
Blowfish

tranlogoptions.mininguser.encryptkey 
Encrypt Key

tranlogoptions.mininguser.miningpassword 
Mining Password

tranlogoptions.mininguser.sysdba 
Sysdba

tranlogoptions.mininguseralias 
Mining User Alias

tranlogoptions.mininguseralias.domain 
Domain

tranlogoptions.noadgtimeout 
No ADG Timeout

tranlogoptions.noasynctransprocessing 
No Async Transaction Processing

tranlogoptions.noddlchangewarning 
No DDL Change Warning

tranlogoptions.noflush 
No Flush

tranlogoptions.noignoredatacapturechanges 
Do Not Ignore Data Capture

tranlogoptions.norequirelongdatacapturechan
ges 

Do Not Require Long Data Capture

tranlogoptions.onephase 
One Phase

tranlogoptions.pathmap 
Path Map

tranlogoptions.pollinterval 
Poll Interval

tranlogoptions.prepareforupgradetoie 
Prepare For Upgrade To IE

tranlogoptions.purgeorphanedtransactions 
Purge Orphaned Transactions
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tranlogoptions.queryretrycount 
Query Retry Count

tranlogoptions.readqueuesize 
Read Queue Size

tranlogoptions.requirelongdatacapturechange
s 

Require Long Data Capture

tranlogoptions.resetlogsidpadlen 
Reset Logs ID Pad Length

tranlogoptions.restartappend 
Restart Append

tranlogoptions.seqpadlen 
Sequence Pad Length

tranlogoptions.server 
Server

tranlogoptions.skipdirloadinsert 
Skip DIR Load Insert

tranlogoptions.startatactivelsn 
Start At Active LSN

tranlogoptions.threadpadlen 
Thread Pad Length

tranlogoptions.transcleanupfrequency 
Trans Cleanup Frequency (min)

tranlogoptions.truncpointoff 
Truncation Point Off

tranlogoptions.tslookupbeginlri 
Timestamp Lookup Start

tranlogoptions.tslookupendlri 
Timestamp Lookup Stop

tranlogoptions.unprivileged 
Unprivileged

tranlogoptions.usenativeobjsupport 
Use Native Object Support

tranlogoptions.useocithreads 
Use OCI Threads
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tranlogoptions.useprevresetlogsid 
Use Previous Reset Log SID

tranlogoptions.userexit 
User Exit

tranlogoptions.validateinlinesflob 
Validate Inline FS Lob

tranlogoptions.vamcompatibility 
VAM Compatibility

transactiontimeout 
Transaction Timeout

transmemory 
Transaction Memory

transmemory.directory 
Directory

transmemory.inittransram 
Initial Trans RAM

transmemory.ram 
RAM

transmemory.ramincrement 
RAM Increment

transmemory.transallsources 
Trans All Sources

transmemory.transram 
Trans RAM

trimspaces 
Trim CHAR to VARCHAR Spaces

trimvarspaces 
Trim VARCHAR to CHAR Spaces

unlockedtrailfiles 
Unlocked Trail Files

updatedeletes 
Update Deletes

updateinserts 
Update Inserts
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updaterecordformat 
Update Record Format

upreporthours 
Up Report Hours

upreportminutes 
Up Report Minutes

use_traildefs 
Use Trail Definitions

useansisqlquotes 
ANSI SQL Quotes

usedateprefix 
Use Date Prefix

usededicatedcoordinationthread 
Use Dedicated Coordination Thread

useipv4 
IPV4

useipv6 
IPV6

userid 
Userid

userid.password 
Password

userid.password.algorithm 
Algorithm

userid.password.aes128 
AES128

userid.password.aes192 
AES192

userid.password.aes256 
AES256

userid.password.blowfish 
Blowfish

userid.password.encryptkey 
Encrypt Key
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userid.sysdba 
Sysdba

userid.thread 
Threads

useridalias 
User Alias

useridalias.domain 
Domain

useridalias.sysdba 
Sysdba

useridalias.thread 
Threads

usethreads 
Use Threads

usetimeprefix 
Use Time Prefix

usetimestampprefix 
Use Timestamp Prefix

vam 
Vendor Access Module

vam.params 
Parameters

varwidthnchar 
Treat NCHAR, NVARCHAR2, NCLOB As
UTF-16

veridatareportage 
Veridata Report Age

walletlocation 
Wallet Location

warnlongtrans 
Warn Long Transaction

warnlongtrans.checkinterval 
Check Interval

warnlongtrans.nousethreads 
No Use Threads
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warnlongtrans.uselastreadtime 
Use Last Read Time

warnrate 
Warn Rate

wildcardresolve 
Resolve Wildcard

wildcardresolve.both 
Intermediate and Dynamic Resolve

wildcardresolve.dynamic 
Dynamic Resolve

wildcardresolve.ignoremissing 
Ignore Missing

wildcardresolve.immediate 
Immediate Resolve

xagenable 
XAG Integration

Other Oracle GoldenGate Parameters/Options
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